MODELAGEM
TRIDIMENSIONAL

COM O RHINOCEROS:
GUIAS ILUSTRADOS

Deborah Macédo dos Santos
Manoel Deisson Xenofonte Aratjo
Henry Péncio Cruz de Oliveira

Celme Torres Ferreira da Costa
(Orgs.)

Autores

Adalia Samara Alencar

Ana Isabela Tavares Gongalves
Arthur Holanda Bezerra

Cicero Tiago Pereira Leite
Crissani Cassol

Deborah Macédo dos Santos
David Kennedy Ferrer Campos Sousa
Dayane Sousa Araujo

Diogo Antonio Silva Ribeiro
Fernanda Kelly de Araujo Ribeiro
Francisco Clayrton Santos
Francisco Leonardo Ferreira Neto
Francisco Luiz das Neves Bezerra
Gleciely Jorge de Almeida
Isabella Jesuino Barros

Israel de Oliveira

Jodo Sérgio Viana Cortes

John Hebert Alves Balbino

Jonas Alves Teixeira

José Jonathan Alencar de Lima
José Vicente da Silva Filho

Julia Alexandra Ramos Silva
Laerthe Aparecido da Costa Fiusa
Leidiane Batista Lopes

Manoel Deisson Xenofonte Araujo
Maria Wellida da Silva Lima
Pedro Henrique Oliveira

Rafael Alves Monteiro

Raimundo Wagner Gongalves
Renata Rosa da Silva

Rhuan Naué Leite Pereira

Rita Edivanira Sa

Ruberflanio Alencar Calheiro

Sara Silva Rocha

Tamires Chaves Duarte

Tamisa Sheila Nogueira de Sousa
Vanilson Carvalho dos Santos
Yagara de Lima Alves

Realizagao

l’ (a Pro-Reitoria de

‘ Pesouisa

fnovacio



Deborah Macédo dos Santos
Manoel Deisson Xenofonte Aratjo
Henry Péncio Cruz de Oliveira

Celme Torres Ferreira da Costa
(Orgs.)

MODELAGEM
TRIDIMENSIONAL

COM O RHINOCEROS:
GUIAS ILUSTRADOS

Juazeiro do Norte
2015



MODELAGEM
TRIDIMENSIONAL

COM O RHINOCEROS:

GUIAS ILUSTRADOS

Organizadores

Deborah Macédo dos Santos
Manoel Deisson Xenofonte Araujo
Henry Péncio Cruz de Oliveira
Celme Torres Ferreira da Costa

Autores

Adalia Samara Alencar

Ana Isabela Tavares Gongalves
Arthur Holanda Bezerra

Cicero Tiago Pereira Leite
Crissani Cassol

Deborah Macédo dos Santos
David Kennedy Ferrer Campos Sousa
Dayane Sousa Araujo

Diogo Antonio Silva Ribeiro
Fernanda Kelly de Aratjo Ribeiro
Francisco Clayrton Santos
Francisco Leonardo Ferreira Neto
Francisco Luiz das Neves Bezerra
Gleciely Jorge de Almeida
Isabella Jesuino Barros

Israel de Oliveira

Jodo Sérgio Viana Cortes

John Hebert Alves Balbino

Jonas Alves Teixeira

Reviséo Final
Denysson Axel Ribeiro Mota

José Jonathan Alencar de Lima
José Vicente da Silva Filho

Julia Alexandra Ramos Silva
Laerthe Aparecido da Costa Fiusa
Leidiane Batista Lopes

Manoel Deisson Xenofonte Aratjo
Maria Wellida da Silva Lima
Pedro Henrique Oliveira

Rafael Alves Monteiro

Raimundo Wagner Gongalves
Renata Rosa da Silva

Rhuan Naué Leite Pereira

Rita Edivanira Sa

Ruberflanio Alencar Calheiro

Sara Silva Rocha

Tamires Chaves Duarte

Tamisa Sheila Nogueira de Sousa
Vanilson Carvalho dos Santos
Yagara de Lima Alves

Dados Internacionais de Catalogagéo na Publicagdo
Universidade Federal do Cariri

M689

Modelagem tridimensional com o Rhinoceros : guias ilustrados/ Organizadores Deborah Macédo dos

Santos ... [et al.]. — Juazeiro do Norte: UFCA, 2014.

186 p. :il. color.

ISBN : 978-85-67915-01-2

1. Design. 2. Joias. 3. Calgados. I. Santos, Deborah Macédo

CDD 745.44




APRESENTACAO

Para o designer de produtos é importante o dominio de softwares que
possam |Ihe auxiliar no estudo estético e volumétrico de seus projetos,
bem como na sua apresentacéo formal para seus clientes. Talvez
essa seja a forma mais rapida e menos dispendiosa para se obter
excelentes resultados de apresentagao, com precisdo de dimensdes e
simulacé&o de materiais, cores e texturas.

Pensando nisso, estuda-se o uso e aplica¢des do software
“‘Rhinoceros” no curso de Design de Produto, com énfase em joias e
calgados na Universidade Federal do Cariri. Durante o semestre 2013-
1 do curso, uma das estratégias de ensino-aprendizagem adotadas
incluiu o exercicio de diversos tutoriais elaborados pela professora da
disciplina especifica “Computacéo Grafica II”.

Ao final do curso, todos os alunos foram convidados a apresentar
suas proprias modelagens em forma de guias ilustrados. Com tema
livre, de modo individual ou em dupla, foram elaborados vinte e quatro
guias que descrevem detalhadamente como executar diferentes
modelagens tridimensionais no software Rhinoceros.

O resultado ficou tdo bom que mereceu ser transformado em livro,
para que outras pessoas possam aprender com os antigos aprendizes
que, hoje ja dominam a arte da modelagem tridimensional com auxilio
do computador.

O livro contém ainda um dos guias que a professora criou e utilizou
durante o semestre, e dois guias do monitor da disciplina que possui
pratica profissional em modelagem de calgados.

O livro foi dividido em quarto unidades de acordo com os temas
recorrentes: Joias; Calgados; Artefatos e Decoracgéo; Objetos e




APRESENTACAO

Personagens ficticios. Os guias foram dispostos por ordem de
complexidade dos exercicios, com o intuito de que um leigo possa
acompanhar sequencialmente os guias e progredir no aprendizado.
Esperamos que este livro constitua uma importante ferramenta de
estudo e aprofundamento do uso do software “Rhinoceros” e que seja
o primeiro de muitos que o curso de Design da Universidade Federal
do Cariri ira publicar.

Obrigada a todos que participaram deste projeto, aos alunos/autores
que se esmeraram no desenvolvimento dos guias, ao monitor Manoel
Deisson Xenofonte Araujo por todo o cuidado com revisbes e
diagramacao que também ajudou na organizac¢ao do livro, ainda a
Pré-Reitoria de Pesquisa e Inovacédo da UFCA, mais especificamente
nas pessoas dos professores Celme Torres Ferreira da Costa e
Henry Pdncio Cruz de Oliveira, que ajudaram na organizacgéo do livro
e no investimento concreto que fizeram para que este tenha de
tornado realidade.

Deborah Macédo dos Santos




INTRODUGAO

UNIDADE 01 - Jéias
PINGENTE EM FORMATO DE COBRA
PEGA DE ENCAIXE PARA JOALHERIA
ALIANGA AMIGOS PARA SEMPRE
PINGENTE OM

PINGENTE INFINITO

ALIANGA ESCULPIDA

UNIDADE 02 - Cal¢ados
FORMA DE CALGADOS
SAPATILHA BASICA
SAPATILHA MOCASSIM

TENIS ESPORTIVO

TAMANCO BASICO

TAMANCO ANABELA

SAPATO FEMININO COM SALTO

UNIDADE 03 - Artefatos e Decoracao
LOGO DO TIME FLAMENGO

CASTIGAL

MANDALA

CADEIRA CIRCULAR

CHUPETA DE DALI

UNIDADE 04 - Objetos e Personagens Ficticios
PINGENTE RELIQUIAS DA MORTE

ELMO DO MAGNETO

MARTELO DO THOR

ESPADA DE THUNDERA

EVA: DESENHO WALL-E

BONEQUINHO LEGO



UNIDADE 01

JOIAS



PINGENTE EM FORMATO DE COBRA

Tamires Chaves Duarte

Atencao: A criagéo e joias com partes pontiagudas nao é recomendada devido
afatores ergondmicos, onde o usuario pode se ferir. Esse projeto tem
finalidade puramente pedagdgica.

1. Apos iniciar o Rhinoceros, ira aparecer uma caixa de dialogo que
contém opgdes de unidades de dimensées e medidas. Como
trabalharemos um objeto muito pequeno, selecione Small Objects:
Millimeters e clique em Open.
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Caso essa janela de dialogo ndo abra automaticamente, vocé pode
selecionar a unidade de dimensao indo no menu “File” > “Propreties”
> “Units” > “Model Unitis: Millimeters”
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[File] Edit View Curve Surface Solid Mesh Dimension Transform Tools A

New. Ctr-N
Open Curl+0

trl-5

Werksession Manager
Send.
Exit

2. Feito isso, maximize a janela “Top” dando um clique duplo sobre seu
nome. Iremos usar um esbogo para dar a silhueta do nosso pingente.
Esse esbogo devera ser uma imagem em formato JPEG, TIFF, PNG ou
Bitmap. Para abrir aimagem ,va ao menu “View” > “Background
Bitmap” > “Place”.



File Edit [View| Curve Surface Solid Mesh Dimension Transform Tools At

Commant  Undo View Change Home
Command Redo View Change End
0 e Pan shit-ame Do S D45 FH
Rotate Ctrl+ Shift+ RMB
ok Zoom »
:i A Set View »
&G Set CPlane ’
3 > Set Camera »
i AC. Viewport Layout »
P Active Viewport (
o9 Page Layout »
&S Background Bitmap ’ Place
o Grid Options..
% da& Capture L
b I:% Close Viewport
(=}
S & Wireftame
™y Shaded
LT Rendered
3‘5’ Ghosted
Iz of
X-Ray
6 Flat Shade
Remesh
Display Options..
Viewport Properties..

3. Ao clicar em “Place”, um a janela de selecdo ira se aparecer, vocé deve
encontrar o arquivo do esboco, clicar sobre ele e clicar em abrir. Logo
apos fazer isso, o programa ira solicitar o posicionamento da sua
imagem. Primeiramente, digite o niumero “0” e apertoﬁj‘Enter”, depois,
digite “25” e aperte “Enter”. Isso fara com que suaimagem se
posicione nos pontos 0, dos eixos x e y, e ho ponto 25 do eixo y (verde).

4. Vocé pode usar a ferramenta “Zoom Dynamic” (atalho no cursor

do mouse)e “Pan” {mJ (atalho no bot&o direito do mouse) para
posicionar a area de modo a poder visualizar todo o esbogo.

5. Vamos comecar a desenhar a silhueta do pingente com a ferramenta
“Curve: Interpolate Points”.

o Iy

:5 18 Curve: Interpolate Foints {
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Use essa ferramenta para percorrer as curvas do e sbogco e acompanhar
sua silhueta:
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*Dica: Quando estiver préximo a finalizagao dessa etapa, habilite a
fungdo “Point” no menu “Osnap”. Isso lhe dara um desenho sem
brechas, totalmente fechado.

6. E normal que , nessa etapa do processo, algumas linhas n&o sigam
fielmente a imagem desejada:

Podemos habilitar a ferramenta “Control: Points On” digitando isso na
barra de comando ou  apertando “F10”, selecionando a silhueta e
apertando “Enter”. Manipule os pontos até obter a silhueta desejada,
vocé pode também usar a sua criatividade nessa etapa:
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Terminando isso, vocé pode desabilitar o Control Points apenas

apertando a tecla “F11”.

7. A proxima etapa sera esconder o esbo¢co que usamos.
menu “View” > “Background Bitmap” > “Hide”.

File Edit
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Command
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8. Assim, temos apenas a silhueta do nosso futuro

Undo Vi

w Change

Redo View Change
Pan

Rotate

Zoom

Set View

Set CPlane

Set Camera
Viewport Layout
Active Viewport
Page Layout
Background Bitmap
Grid Options...
Capture

Close Viewport
Vireframe
Shaded

Rendered

Ghosted

Flat Shade
Remesh

Display Options...

Viewport Properties...

View | Curve Surface Solid Mesh Dimension Transform Tools A1

Heme
end |
swr-rme i O @5 FH

Ctrl=Shift-RME

v Place
Refrech
» Remove

Extract

Hide

Move

Llign

Scale

Para isso, va no

pingente. A proxima

etapa sera desenhar um orificio por onde a argola desse futuro pingente

passara. Para isso, va a ferramenta

“Circle: Center, Radius”

@)

e

clique no local por onde vocé deseja que o pingente seja pendurado.
Digite “0.25” e aperte “Enter”. Teremos algo semelhante a isso:
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9. Agora, vamos dar volume a pega. Saia da vista Top dando novamente
um clique duplo sobre seu nome. Entao, clique no botdo da ferramenta
“Extrude closed planar curves”:

O Extrude closed planar curve

.
S
=
ANCNE ;
S &

Selecione todas as linhas desenhadas (clicando sobre cada uma delas
ao mesmo tempo em que segura a tecla “Shift”), digite ~ “2.5” e aperte
“Enter” trés vezes seguidas. Veja a dimensao da nossa pega em varios
angulos:
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10.Podemos fazer uma argola para o pingen te com a ferramenta “Elipse:
Diameter”:

—~ (s . & Elipse: Diameter

Para isso, na vista Top, vocé ira clicar no centro do orificio, depois,
levara a linha para cima e dara um novo clique, assim:
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Sem fazer mais nada, leve o mouse até a vista “Right” e determine a
altura da elipse. E importante que ela enlace seu pingente, assim:

Com a altura da elipse determinada, dé mais um clique.

11.Para dar volume a elipse e transforma-la em uma argola, clique no botéo
da ferramenta “Pipe. Flat caps”

hROQD
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Selecione a elipse, digite “0.05” e aperte “Enter” duas vezes seguidas.
Nossa argola devera ficar assim:

12.Que tal simular um detalhe em pedraria? Para construir a pedra,
primeiro, vocé deve criar uma nova camada exclusiva para ela, clicando
no botdo “Edit Layers”

& B0 0

B Edit Layers
B Close layers

Ao clicar nesse botdo, uma caixa de camadas aparecera no lado direito
da area de trabalho do programa. Nela, vocé dara um clique duplo sobre
o nome “Layer 01”.

Layers - All Layers <o [
Oy x «a « 4 7 2 7
Name Matei
Default Yol

Layer 02 N

Layer 03 e |

Layer 04 [P |

Layer 05 =

13.Para comecar a desenhar a pedrinha, leve seu mouse até a vista “Top”,
e cliqgue sobre o botéo da ferramenta “Pyramid”.




Depois disso, vocé ira clicar em algum ponto da vista fora da serpente.
Entéo, ir4 digitar “0.4” e apertar “Enter”, depois , clique no plano
novamente, digite “0.3”, olhando para as outras vistas, observe se o
topo da piramide esta posicionado para cima, entédo, aperte “Enter” e dé
um novo clique sobre o plano. Temos assim, uma pedrinha:

14.Para posicionar a pedrinha como detalhe de olho na serpente, vocé
pode mové-la para cima do pingente usando a ferramenta “Move”

T
6 o]

Ou, pode simplesmente arrastar a pedrinha para cima do pingente com
0 botao esquerdo do mouse.

15.Porém, quando manipulamos objetos em 3D, é comum que nos
confundamos com o espaco e que a ilusao de 6tica deixe a pega em um
lugar que n&o esperamos. Usando o botdo esquerdo do mouse e
girando a peca na vista “Perspective”, podemos ver isso claramente,
como nas imagens abaixo, onde a peca apare ntemente se encontra em
cima do pingente:
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Para resolver isso, vocé pode arrastar pedrinha para a superficie do

pingente na vista “Front” ou na vista “Right”. O “Zoom Dynamic” 8
pode Ihe ajudar nessa tarefa.

Vocé também pode posicionar a pedra  um pouco abaixo da linha de
superficie do pingente. Isso dara a impressado que a pedra esta cravada
na pega.

16. E chegada a hora de colorir nosso pingente! Para isso, vocé pode se
dirigir ao menu de camadas e clicar sobre um circulo que aparecera logo
apos o indicador da cor da camada:

. Layers - All Layers <o saisn @]
OB x a4 T F 72

MName IMatel

g
Layer 03 Qo
Layer 04 9o

g

¥ =il 1@
Layer 01 O
Layer 02 Iﬁ
|
[}
Layer 05 O

Isso fara uma caixa de edi¢cdo de materiais aparecer:
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& =
Assign by
Plug4n
@) Basic
Basic
MName
Color 1]
Gloss color [ |
Gloss finish 0 3
Transparency
=[] Texturs
Map file [i\Users\ta08res -.PiI:\
Intensty. % 100 4
Filtsr ] 0On
Tiling | Modify. |
=[] Transparency

Map file fnone) [)

{none) [:I

= |[¥] Envionmert

Map file C\User'talSres... [

Intensity, % 100 =

Fiter @on

Tiling Modify |
[ Match |
‘ oK | | Cancel ‘ ‘ Help |

Nela, vocé pode selecionar a opgao “Texture” e adicionar uma imagem
previamente estabelecida com a textura que vocé deseja aplicar a pecga.
Fazendo o mesmo processo e selecionando a opcao  “Environment”,
vocé pode selecionar a mesma imagem que aplicou a textura para dar a
pega uma aparéncia brilhante de verniz.

17.Para colorir a pedra, devemos selecionar a camada em que ela foi
desenhada e clicar no circulo correspondente:

Layers - All Layers B
OB x «a» 47 & 72

| Name Mate

| Defaut =d Le)

Na caixa de edigdo de materiais, vocé pode atribuir cores para a
pedrinha clicando sobre a barra de cor, que fica ao lado direito de
“Color” e selecionando uma a seu gosto. Estabeleci o azul:
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Assign by

() Plugdn
@ Basic
Basic

MName

Color (—
Gloss cclor I

Gloss finish 50 fte]
Transparency 35 [

Na barra “Gloss color”, podemos determinar a cor do brilho da pega.
Nos valores de “Gloss finish” e “Transparency”, podemos atribuir
valores em porcentagem para a intensidade de brilho e pa ra o indice de

transparéncia, respectivamente.

18. Ao terminar todo o seu processo criativo, para que se possa ver o
resultado, vocé pode maximizar a vista “Perspective” dando um clique
duplo sobre seu nome e posicionar a pega de maneira que possamos
ver todos os seus detalhes. Determinando essa posicao, é so clicar

sobre o botdo “Render” ‘ Abrird uma janela com a simulagao de
sua pega pronta:

B3 Rhvno Render (1:1): Unnamed-14 ErevE
Fie E6t Zoem Help

Completed
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Resultado




PECA DE ENCAIXE PARA JOALHERIA

Jodo Sérgio Viana Cortes
Pedro Henrique Oliveira

APRESENTAGAO

Inspirado nos jogos de quebra-cabeca e brinquedos de lego, o objeto desenvolvido neste
tutorial é bastante simples e facil de ser feito. Resultando numa maneira descontraida do
seu uso, pensamos em algo que servisse como base para um broche, brinco oy cola
cabendo a qualquer um colocar seu lado criativo em pratica, e montar seu proprio

acessorio, podendo ser executado em diferentes formatos e varios tamanhos.

TUTORIAL

1. Abra oRhinocero escolha a escalearge Objects- Centimeters

2. Maximize a vista TOP, e desenhe o formato da pega com a ferramenta Polyline,
seguindo as medidas da imagem abaixo (caso queria mudar as proporgdes, vocé
pode desenhar com medidas maiores ou menores, ou apenas usar a ferramenta
SCALE.)

Prog e

Gl Saes  rupr Loyt ikl Trwabem G Tosn S s T | Dfing | i

u G G oo St Teoh S Teck Mk T 2
BOntt + 202 TH~ 574090000 T8L0

lcm 2cm
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. Ainda na vistaTOP,com a ferramenta CIRCLE, CENTER, RADIUS, desenhe um

circulo pequeno de 0,2cm nos lugares desejados (ou necessarios para montagem)

e replique o na pega com a ferramenta MOVE> COPY.
. T =
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Minimimize a vistaTOP e maximize a vista RIGHT.
Selecione toda a pecga e depois clique na ferramenta EXTRUDE CLOSER

PLANAR CURVE e dé uma extrusdo de 2cm.
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Agora, na aba de camadas (na lateral direita), clique no circulo pe queno branco
que fica ao lado da cor da camada, e ajuste as propriedades de cor, transparéncia,

brilho e refletividade.
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Selecione toda a pega, replique copiando e colando, gire com a ferramenta
ROTATE-2D e depois, com a ferramenta MOVE faga os encaixes desejados.

30 =33 K8 - Rtinoceros (Educationsl) (64510 - Perspective] - E W Y - : Wy E=ttcl =)
Fle Edt View Cuve Sufsce Sohd Meh Dimension Tamfom Tools Ansher Fender Panels Help
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SEEDAE
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9. Escolha a melhor posicao, clique em RENDER e finalize seu objeto.

Imagens llustrativas
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ALIANCA AMIGOS PARA SEMPRE

Francisco Leonardo Ferreira Neto

PASSO A PASSO
Abra o Rhino selecione Large object milimeters. Na vista Front use a ferramenta circle Center
radius, digite O e enter e em seguida digite 30.

Agora na vista Right faga uma curva usando a ferramenta Arc: Start, end, direction at start.




Em seguida com a ferramenta Polyline faga igual a figura abaixo.

Com a ferramenta Move: copy ...Selecione a curva feita e posicione de
forma que ela toque nas linhas feitas como na figura abaixo.

Fie Edt View Cuve Susce Sobid Mesh Dimension Transform Tools Anshyze Render Help

Command:_Copy
 Point to copy from ( Yeticalsho lnPlace | | EED

e
5,0,550

DEAS e hBDLOROVAY |

CPlane  x0.00 y 4500 2000 000 WDt




Agora vamos unir as linhas e as curvas formando uma figura sé, para isso vamos usar
ferramenta Join =3

Em seguida selecione todas as partes citadas anteriormente. E digite Enter.

Cumve Sufsce Sobg Mesh Dimension Transform Tools Ansiyze Render Help
4 curves joined intg
Command: |

TXQ0-O+RP50H8 cw>T 7 ARO00R T®IL; @

Ty 1
DBxa~-d4VRT
Neme Mater.
Defodt L]
Leyer 01 Yol
Layer 02 Gam
Layer 03 ‘om
Layer 04 vam
Layer 05 vd0

Na vista perspective, Clique na ferramenta Surface: Sweep 1 rail, selecione toda a figura e
digite Enter \

Ficard assim:

Fle Edt View Cove Sufsce Soid Meh Dimemsion Trnfom Tools Ansyre Render Help
Commane:_ CopyToOkgnoan
Command:




Use o Shaded Viewport.

I.*—'.g;'_'ﬂ—-_:alh-‘ m

Seguindo essas etapas:

1 - Va para a vista Top e com a ferramenta Text digite uma frase. 2- Trace uma reta
ultrapassando o que vocé acabou de digitar, com o comando Flow selecione a frase e dé Enter,
3- logo selecione a reta projetando onde ficard a escrita.
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Ap0s finalizar a pega vocé podera colorir, basta ir em Layers.




Resultado




TUTORIAL PINGENTE OM

Ana Isabela Tavares Gongalves
Crissani Cassol

1. Crie um novo documento no Rhinoceros;
2. No Menu View selecione a opgéo “Background Bitmap/Place” ;

DEM e AELORGVArF O
L ¥t bRARS OG- O

3. Digite 0 e dé Enter, depois digite 5 e dé Enter;
4. Usando a ferramenta “Curve:Interpolate Points” contor ne todo o desenho.

jetm
@7
x93
@
&
L0
Bisd
aa
3y
T
Ed
o




5. Usando a ferramenta “Circle:Center,Radius” faga o circulo do desenho;

Cume_furtsce Soid Men Demnsiem Tramorn Toon Anster RenderHelp
otson P e Degree=) hnots=Cnond Endlangent Giose Sharp=hn Uno |

;Dmuﬁﬁxnnoﬁvnopmﬁm—q@rvntooaa1@%0

e through
selected locations in space.

Mote: Many CAD programs use
tha tarm spéne to descroa an
interpalated curve.

Stops:

1. Pick the start of the curve,
2. Fick the next poiats.

3. Press Entar to and the

6. Va novamente ao Menu “View/Background Bitmap/Hide” , para apagar a figura
padréo.Seu desenho deve estar igual a imagem abaixo:

i

I}

LE Thrlch X dlwl
FRGQD I G-

> & 510

QA @
§ e
it

@
k
P
¥
i
<

1t ) o] Pt [ Tmch ] D
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Usando novamente a ferramenta “Circle:Center,Radius” faga um circulo

envolvendo todo o desenho. Selecione todo o seu desenho e use a
“Join” para unir cada uma das partes;

ferramenta

Oraws a circle perpendicuiar to
the construction plane.

£ et ] Pt [ 5Tomch ] Dt
Gnha Planar

DR e RALEEGTET

1umd I Kot (] Prpeet [ $Truck ] Db
e Panar

Drams & Circle parpendicuiar to
the construction plane.
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9. Selecione os desenhos dentro do circulo e use a ferramenta “Group” p ara
agrupa - las;

Fie G4t Vew Cuve Swface 5ok Meh Dimensos Trenom Took Amiyis Raeder Help
Y
0

D'ei&ﬂxhnnﬂwb PPH=s>*7068000 B0 @ )
|

[P
v
l

Fauns anather appiication from
ingice Ao,

Steps:
b Typa the name and pathof

TN :m o Lu. 10ud ] et U....-w_.n_
CPlane = 015 Sl Rl o

10. Na vista “Front”, usando a ferram enta “Move”, mova os elementos par a parte
superior do circulo pressionando a tecla “Shift”;

Dt Odha Planar O
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11.Com a ferramenta “Extrude:closed planar curve” , digite-‘0.5”;

o me 1o 100

O TBLE

Moves abjects from ena
spaciied location to anather.
Stops:

1. Select objects.
2. Pick # point 1o move from.

3. Pick 3 pont to move ta.

£ et Pt [ 5Trck ] Dot
Gana Pl ©

12. Selecione o grupo de linhas guias e mande para uma outra camada,clicando com
o botdo auxiliar na camada e selecionando “ChangeObjectLayer’.Esconda a
camada

e

DeE@FX R0t +L0 L H=s-> 9030000 T®5,@
NE [Too ] Layers - aa Command Help a
3 Bbx-~iTA?
Ad o @)has Lt
ollc] [P | e "
joife] [t o Cument shades the
& it S Properies + | Thia ot 2 working
9 i | e
@& iamal s
F-p = et
L st to cancal the
& 5 et Scton :
&% Seiec Obyeces
Change Onect
;} E-nm-::«
b Ghosted
xmay

s o (] e [l STk ] Daie
OrbaPlanar O
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13. Selecione todos os objetos que formam o desenho, exceto o circulo,e com a
ferramenta “Group”, agrupe-os;

RS Uroties - Rhunoc

Fie Ede Vew Cuve Sutse Soid Men Demmnsen Tmiom Tooh Ambr Remder Heip
Commang_Grove.

Command:

DBHBFXD0 0+, 0P H=s>+982000d ®5LO

Crastas 3 sngle unst from

selectod cbjocts.

Hotes

* Groupng sows sl grouped
objects to be selected as |
ane

# Commands apply to the
entre group.

Grouging > Group

R e
O Planar

14.Usando a ferramenta “BooleanDifference”, selecione o circulo, dé
Enter,selecione uma imagem de dentro do desenho e dé Enter;

Fie G4t Vew Cue Swfece SR Meh Dinsos Trendom Took Amiyie Raeder Help

Craates a sngle unit from

selacted objects.

Hotes

 Grouping alows ol grouped
obects to be sebected 35 |
ane.

# Commands apply ta the
ntee group.

Grouging > Group
M3 > Group.

EL BEPY 1P Tokefob vl

Bt > Grovps > Group.

ayboard Shartcut: Cil +
3

L) Retated topics...

Ouss [ or ] Pt [ STkl O
GnaPlnar
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15.Esconda a camada dos objetos (clicando na lampada em frente a camada que
deseja apagar);

A —
Commana _Snase N
i e —

BOFXD0D N 42 OIPFBee=>r78B000@ 1®5LO
[Top |

o B E D )0 G

0 3
5

The hyphensted varson

Salsctederas/to

e I o ] et [ $Trch ] Die:

16.Na vista front selecionar as linhas guias do desenho e utilizando a ferramenta
“Move” leve o desenho para baixo;

17.Utilizando a ferramenta “Extrude:closed planar curve” selecione o desenho de
dentro e digite 0.7 e de enter.

18.Visualize novamente a camada apagada
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19.Na camada Default clique na bolina que esta na frente da cor e selecione textura

20.

21.

selecione a imagem “textura” e a apligue

Fie fdt Vew Cue Sutice Seid Men Oemnssm Tndom Tooh Ay Reeder Help
Orawitres=tio DrasGnosves Drawsses:ves )

Canese
Command.

W

aD’x QOO+ PO AR Hme=2008 uooao T, @

DERNI e LBHOROVAYF O
i?&;a&n&saaneu-

Salsctederas/to

Standar > Shade

Repita a agdo na camada “Layer1”,selecionando a imagem “Textura 27;

Na vista front usando a ferramenta “ Cylinder” digite 0.1, e puxando para a vista
Right digite 7 e dé Enter;

Fie fdt Vew Cuve Sutwe Soid Men Demmnsen Tumdom Took Anbye Reees Help
‘unanng Cyinder
Command:

D@Uﬁﬁxhﬂﬂﬂ*ﬁbﬂﬂﬁﬂ-QQF'ﬂUOOGO‘@%O

Q#HJBLfNAAQV@>v
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22.Utilizando a ferramenta “Rotate” para que fique cruzando o objeto na horizontal
movendo e rotacionando o posicione de acordo com a figura abaixo:

Fit Ede Vew Cuve Sutse Soid Meh Demnsen Tnndom Tooh Amie Remder Heip.
Unseing Bcaiestweence

EEHSFXR0~N+ 20 0P Hme >R AB000@ TBLEO
| Top |

|

o

e ARGRO IO G -

RN eEBLORVArF D

Ouss [ (] Pt B STk ] D

23.Com a ferramenta “BooleanDifference”, selecione o circulo, dé Enter, selecione
o cilindro, dé Enter.

Fit Ede Vew Cuve Sutse Soid Meh Demnsen Tndom Tooh Ame Remder Heip.
Commang_BosteanDsterance.
Taloct st 2ot of curlaces of pabyeartaces K

DeEd@fxb0-~N+L0 0 H=s-"70B0008 "®LE
F [Perspecive |

DAL ®=E008

it ) bt ] Pt [ Tk ] e
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Resultado




CRIACAO E RENDERIZACAO BASICA
DE PINGENTE EM FORMATO DO INFINITO

Cicero Tiago Pereira Leite
Arthur Holanda Bezerra

1. Apos iniciar o Rhinoceros, ira aparecer uma caixa de dialogo que
contétm opc¢des de unidades de dimensdes e medidas. Como
trabalharemos um objeto muito pequeno, selecione Small Objects:
Millimeters e clique em Open.

] Ask every time Rhino staris

Open Help

Caso essa janela de dialogo nao abra automaticamente, vocé pode
selecionar a unidade de dimensdo indo no menu “File” > “Propreties”
> “Units” > “Model Unitis: Millimeters”

& J ———
File) Edit View Curve Surface Solid Mesh Dimension Transform Tools Al

New.. Ciri-N
Open, CHr-0

Save As Template...

Insert, Ctrl+1
Import

Export Selected.

Export With Origin.

Hetes

Properties.

Print,

Worksession Manager...
Send.

Exit

2. Feito isso, maximize a janela “Top” dando um clique duplo sobre seu
nome. Iremos usar um esbogo para dara silhueta do nosso pingente.
Esse esbogo devera ser uma imagem em f  ormato JPEG, TIFF, PNG .
Paraabrir a imagem , va ao menu “View” > “Background Bitmap” >
“Place”.
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| ™ | Untitled - Rhineceros (Educational Lab License) -[Topl |
File Edit [View| Curve Surface Solid Mesh Dimension Transform Tools Ar

: Commang Undo View Change Home
Command  pyo view Change End
E—
BN=} Pan swinermve D)0 @5 FH
“E Rotate Ctrl~ Shift RMB
o R Zoom »
teil)! TS :
(G @ Set CPlane v
o > Set Camera »
g kS Viewpert Layout »
3| Active Viewport v
@’ g/ Page Laycut v
g
= Background Bitmap » Place
Lol ..

& Grid Options... Refresh
u % Capture » Remove
&b Close Viewport bt
S &, Wireframe i
Y Shaded i
AT e Move
I])f og Ghosted o

Yofay Scale
i =] Fist Shade V| Grayscale

Remesh

Display Options...

Viewport Properties...

3. Ao clicar em “Place ”, uma janela de selecéo ira se aparecer, vocé deve
encontrar o arquivo do esbogo, clicar sobre ele e clicar em abrir. Logo
apos fazer isso, o programa ira solicitar o posicionamento da sua
imagem. Primeiramente, digite o numero “0” e aperte “Enter”, depois,
digite “30” e aperte “Enter”. Isso fara com que sua imagem se
posicione nos pontos 0, dos eixos x e y, e no ponto 30 do eixo y (verde).
Ficarar assim .

Fle Ede View Cume Sufsce Sobs Me Dimenon Tmefom Tooh Answae Render Hep
‘Chonss backyicund Timae option { 4gn ETct Grapscala=yas Fitar-Ho ove Piace Retesh Remow Scase Visied=Yes | g
Command: =)

DeE8FXB0-~N+A0ARpTH=s-r08P000@ %@

Jo

4. Vocé pode usar a ferramenta “Zoom Dynamic” *  (atalho no cursor do

mouse) e “Pan”ﬂ (atalho no botao direito do mouse) para posicionar a
area de modo a poder visualizar todo o esbogo.
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5. Vamos comecar a desenhar a silhueta do pingente com a ferramenta
“Curve: Interpolate Points”.

@Ir2OO
@ Curve: Intsrpolate Poirts uin
& Curve: by Handles 2 b

Use essa ferramenta para percorrer as curvas do esbogo e acompanhar
sua silhueta:

Fle Bt View Cuve Sufsce Sobd Meh Dimenson Tmedom Took Anshae Render Hep
50 cune point
Command:

DeE3FXR0~ Ny 25 0pFfHee=r7aR000R T&L:@

eVQare
L §F%, 0 bRGQo IO -

DEAS 2 RELOA

st kot (] Pt [ T ] b
Soap_ Oho_Planar_ Orap

ol S @ o @ |8 %
*Dica: Quando estiver proximo a finalizagdo dessa etapa, habilite a
fungdo “Point” no menu “Osnap”. Isso Ihe dara um desenho sem
brechas, totalmente fechado.

6. Pode ser, que nessa etapa do processo, algumas linhas ndo sigam
fielmente a imagem desejada:
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Podemos habilitar a ferramenta “Control: Points On” digitando isso na
barra de comando ou apertando “F10”, selecionando a silhueta e
apertando “Enter”. Manipule os pontos até obter a  silhueta desejada,
vocé pode também usar a sua criatividade nessa etapa:

Terminando isso, vocé pode desabilitar o Control Points apenas
apertando a tecla “F11”.

7. A proxima etapa sera esconder o esbog¢o que usamos. Para isso,

esconda utilizando o comand o“Hide”.Assim, temos apenas a silhueta
do nosso futuro pingente.

[}
CH
8. Selecione a silhueta e click a ferramenta Copy " BB ANOGm@&EB
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A) GNOGEIN EINOOGNHNGBMONOPN FOORBABGMZN @ENOWN MNGPN NOO O NOF

esquerdo do mouse. Para ficar igual a figura a baixo.

EA ENOPM @peN Ordm BN @ NEINPMBI imagen a baixo, depois aperte com o botdo
esquerdo do mouse e enter.

9. vaaferramenta “Circle: Center, Radius” @, e clique no local por
onde vocé deseja que o pingente seja pendurado. Digite “0.9” e aperte
“Enter”. Teremos algo semelhante a isso:

Caso o circulo n&o fique com na imagen. E facil corregir! Basta
selecionar o circulo com o botdo esquerdo do mouse e arrastar ate o
ponto certo.

10.Agora, vamos dar volume a peca. Ainda com o circulo selecionado,
cliqgue no botdo da ferramenta “Pipe, Flat Caps”:

5 Pipe, Flat caps
2 Pipe

digite “0.5” e aperte “Enter” duas vezes seguidas. Veja como fica.
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Agora selecione um infenito, em siguida a ferramentaPipe, Flat Caps.
Pipe, digite 0.68 aperte enter trés vezes, depois ESC.

Repita o0 mesmo processo com as outras duas formas do infinito, o triplo infinito ficara
assim.

54 Podemos fazer uma argola para o pingente com a ferramenta “Elipse:
Diameter”:

b | 18 Elipse: Diameter

Para isso, vocé ira clicar no centro do orificio, depois, levara a linha para
cima e dara um novo clique, assim:
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Sem fazer mais nada, leve o mouse até a vista  “Right” e determine a
altura da elipse. E importante que ela enlace seu pingente, assim:

Com a altura da elipse determinada, dé mais um clique.

12.Para dar volume a elipse, clique no botdo da ferramenta “Pipe. Flat
caps”

Selecione a elipse, digite “0.01” e aperte “Enter” duas vezes seguidas.
Nossa argola devera ficar assim:

o
H

Duplique a nossa argola usando =B ENO@M MEBMmGM NOGEGRMihagen

a baixo, depois aperte com o botdo esquerdo do mouse e enter.
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G AR PASE A
P . =2/ 6 Foiyine 3l .
Usando o comando da “Polyline” :rl_ii=sm S selecione o

primeiro ponto e aperte o botdo esquerdo

Depois leve a linha, a outra argola e aperte o botdo esquerdo e enter.

" !i!
LR ]
iqu W i i i i b
Clique na ferramenta “ Sweep 2 Rails ”¥ @ ®mi#ic==:"=| selecione a prim eira argola

segunda argola e a polyline. Depois enter.

Aparece-ra essa caixa de dialogo aperte em “OK”
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13.E chegada a hora de colorir nosso pingente! Para isso, vocé pode se
dirigir ao menu de camadas e clicar sobre um circulo que aparecera logo
apos o indicador da cor da camada:

Layers - All Layers (=]

Isso fara uma caixa de edicdo de materiais aparecer:

E¥ Material Editor [

Resign by
Pugin
@ Basic
Basic
Name
Color
Gloss color
Gioss finieh
Transparency
Testure
Mzp file o

Trarsparency

Mapile pene

Burp
Map fie

Enviorment
Map fie frane:

Match...

oK Cancel Help

Nela, vocé pode selecionar a opcado “Texture” e adicionar uma imagem
previamente estabelecida com a textura que vocé deseja aplicar a peca.

Fazendo o mesmo processo e selecionando a op¢gdo  “Environment”
vocé pode selecionar a mesma imagem que aplicou a textura para dar a

peca uma aparéncia brilhante de verniz.

)

14.Para colorir o pigente, devemos selecionar a camada em que ela foi
desenhada e clicar no circulo correspondente: como o pigente foi criado
em apenas uma Camadal/Layers sera a camada com o home Default
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Na caixa de edigdo de materiais, vocé pode atribuir cores clicando sobre
a barra de cor, que fica ao lado direito de “Color” e selecionando a cor
ouro:

Na barra “Gloss color”, podemos determinar a cor do brilho da peca.
No caso escolhi a cor amarela. Nos valores de “Gloss finish” (Usei 14)e
“Transparency”(Usei 2), podemos atribuir valores em porcentagem
para a intensidade de brilho e para o indice de transparéncia,
respectivamente. Depois é sé apertar em OK.

3 Matens! Edtor =

Resign by

Pugin
8 Basc

15. Ao terminar todo o seu processo criativo, para que se possa ver o
resultado, vocé pode maximizar a vista “Perspective” dando um clique
duplo sobre seu nome e posicionar a peca de maneira que possamos
ver todos os seus det alhes. Determinando essa posigéo, é sé clicar

sobre o botdo “Render” e Abrira uma janela com a simulagao de
sua pega pronta:
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ALIANCA ESCULPIDA

Renata Rosa da Silva

1. Com a ferramenta "background bitmap", insira a imagem abaixo na vista "TOP" da drea de
trabalho do rhinoceros:

a. clique com o botdo direito do mouse em cima da palavra TOP
b. mova o cursor para cima da palavra: Background Bitmap

c. Clique na palavra "Place" e selecione a imagem.

d. Clique em dois pontos distintos na vista top, para inserir a imagem

a. Desenhe somente um dos elementos que se repetem na figura

b. Com a ferramenta "Mirror" espelhe o desenho para a direita a partir do local indicado
abaixo. (esse local serd o eixo de espelhamento)




a imagem ficara assim:

c. Use o mesmo procedimento para espelhar as duas figuras para abaixo. O resultado do
espelhamento sera proximo ao indicado abaixo:

2. Na vista Front desenhe um circulo utilizando a ferramenta "Circle, center, Radius" com o
diametro de 20mm

a. Selecione a ferramenta "Circle, center, Radius".

-
A
e,
2=}

b. Cliqgue em um ponto qualquer para indicar o centro do circulo

c. Digite o valor 20
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3. Na vista Perspective, faga uma extrusdo a partir do circulo desenhado:

a. Selecione a ferramenta "Surface: Extrude straight"

b. Selecione o circulo desenhado e digite o valor 22

O resultado devera ficar assim:

4. Com a ferramenta "Surface Tools : Offset Surface", de volume ao cilindro gerado:
a. Selecione a ferramenta "Offset Surface" e depois o cilindro.

b. Certifique-se de que as setas brancas estdo apontadas para fora. Caso ndo estejam,
seleciona a opgao "FlipAll" na barra de comandos.

c. Na barra de comandos, certifique-se também que a opgdo "Solid" esteja marcada como Yes.
Caso ndo esteja, clique na palavra que ela mudara de "no" para " Yes".

d. Digite o valor 3, que sera a espessura do anel.

O resultado devera ficar assim:
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5. Gere uma linha no meio do cilindro com a ferramenta "Curve: averange 2 curves'".

a. Selecione a ferramenta " Curves: averange 2 curves"

EJ Average 2 Curves

b. Selecione as bordas superiores do cilindro como indicado na foto:

c. Essa ferramenta possibilitou gerar uma linha no centro do cilindro:
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6. Meca e anote o valor do comprimento dessa linha gerada:

a. Selecione a ferramenta "Analyze direction: Lenght"

c. Anote o valor que aparecera na barra de comandos.

7. Redimensione a figura desenhada no inicio para os valores de largura e de comprimento
do anel.

a. Selecione toda a figura desenhada no inicio.
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b. com a ferramenta "Scale 1d" selecione o extremo inferior do desenho e depois o extremo
superior do desenho e digite o valor gerado no passo anterior.

c. Ainda com a ferramenta "Scale 1d" Selecione o extremo lateral direito e depois o extremo
lateral esquerdo da figura e digite o valor 18.

d. Por fim, rotacione todo o desenho a 90 graus, de forma que fiqgue no mesmo sentido do
cilindro, com a ferramenta "Top: Rotate 2D 3D"

0 Rotate 2-0|
Reotate 3-D

o desenho ficara assim:
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8. Insira o desenho na superficie do anel com a ferramenta "Flow"

a. Selecione toda a figura e depois clique na ferramenta "Box: Boundig Box" e clique enter,
Essa

ferramenta ird gerar uma caixa em torno de toda a figura que servird como referencia para o
ponto medio.

b. Trace uma linha do ponto medio superior da caixa até o ponto médio inferior da caixa. Essa
linha servira para base na ferramenta "Flow"
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c. Na vista Perspective, selecione a ferramenta "Move: Flow along curve", depois selecione
toda a figura e clique enter.

& @0
2 8@

d. Depois selecione a linha mediana e clique enter

e. Por fim clique na linha do cilindro.



o resultado ficara assim.

9. Com a ferramenta "Split", divida a superficie do cilindro usando o contorno desenhado.

a. Selecione o cilindro e depois a ferramenta "Split"

-~

b. Selecione as linhas da superficie do cilindro

c. Agora a superficie do cilindro foi dividida exatamente nas linhas desenhadas.

10. Com a ferramenta "Offset Surface", selecione as superficies internas divididas e de
volume a elas.

a. Selecione as superficies indicadas em vermelho:
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b. Selecione a ferramenta "Offset Surface", certifique-se de que as setas estejam voltadas para
cima, digite o valor 1 e aperte enter.

TR 9964 %
9O 0% %
2. Ylemmsmalt &
eI L L
L DL
‘ooi"léa

N 9.,

O resultado final devera ficar assim:
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UNIDADE 02

CALCADOS



MODELAGEM DE FORMA DE CALCADOS

Manoel Deisson Xenofonte Araujo

Para fazermos a modelagem de uma forma de calgados 3d precisamermos
inicialmente de um modelo de referencia. Utilizaremos para tanto as duas
imagens abaixo, correspondentes respectivamente a palmilha e ao perfil da forma.

No entanto outras imagens poderdo ser utilizadas para o mesmo fim, como uma
fotografia de um pé, ou de um tenis ou sandalia. O importante &€ que se tenha um
perfil e uma palmilha.

PASSO A PASSO:

1- Na vista TOP insira a imagem da palmilha com a ferramenta
BackgroundBitmap:

a - Clique com o boté&o direito do mouse na aba TOP e escolha a op¢éo:
BackgroundBitmap - Place

b - Apos selecionar a imagem, clique em dois pontos distintos da tela TOP, isso ira
inserir a imagem selecionada.

Restore

Wiretrame
Shaded

& Rendered
Ghosted
X-Ray
Technical
Anstic

Pen
Print Preview

Fist Shade.

Shade Selected Objects Only
Pan, Zoom, and Rotate
SetView

Set CPlane

Set Camers

Active Viewpert
Viewpart Layout

Background Bitmap
Grid Optians.. Refresh

Capture » Remove

Close Viewport ot

Hide
Show

Clipping plane
Refresh Shade

Display Options.
Niewport Properties...
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2 - Na vista RIGHT insira a imagem do perfil da forma utilizando-se dos mesmos
recursos do passo anterior.

Restore

weetiame
Shaded

*  Rendered

Ghested

XRay

Technicsl

Anitic

Pen

Print Preview

FiatShade

Shade Selected Dkjects Only

Pen, Zoom, and Rtate

Set View »

Seb CPlane

St Camers .

Active Viewpost

Viewpor Layout

Bockground Bimap

Giid Option.

Coptee | Remewe

Close Viewport

Chpping plane

Refiesh Shade

Display Options...

Viewpar Propertics

3 - Na vista TOP desenhe o contorno da palmilha utilizando-se da ferramenta:
Curve: Interpolate Points. Depois desenhe a forma que se encontra no desenho
abaixo, na posigao indicada

O Curve: interpolate points
@ Handle curve
7 g
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4 - Na vista RIGHT selecione a ultima forma desenhada e arraste ela para a
posicao do topo da forma, com indicado na figura abaixo:

5 - Ainda na vista RIGHT, desenhe uma linha contornando todo o perfil inferior da
forma, como indicado logo abaixo:

6 - Utilizando-se da ferramenta: Curve from 2 Views, na vista PERSPECTIVE,
selecione a linha desenhada na etapa 5 e em seguida selecione o contorno
desenhado da palmilha

Essa ferramenta ira fazer com que o contorno da palmilha siga a curva da linha
do perfil.
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b - Na vista FRONT, edite as linhas restantes para que fique no seguinte formato:

9 - Por fim selecione todas as linhas desenhadas e clique na ferramenta: Curve
Network:

10 - Resultado:




MODELAGEM DE SAPATILHA BASICA

Manoel Deisson Xenofonte Araujo

1- Abra o arquivo: forma de calgado 3dm. BV

2- Na vista right selecione a férma 3d e a esconda utilizando o comando Hide - '—’_,L%D,‘_QA [E'. Q. o.

3- Agora desenhe os contornos do calgados utilizando a ferramenta
Curve Interpolate Points e Polilyne da seguinte maneira:

— KIignt |¥
a - Com a ferramenta Curve Interpolate Points, @ -} i — l

desenhe os seguintes contornos ! 4@ i _]

(as linhas devem ultrapassar o desenho): ] @; 5] bl ) O o
:\“q “k 8of [ o,
NG~
&9
< D

b - Com a ferramenta Polilyne |j ﬂ desenhe a alca da sapatilha

4- Selecione todas as linhas e com a ferramenta Trim, ||:!>| corte as intersegdes das linhas.
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5- Com a ferramenta Join, ﬁh una as curvas selecionando os 3 segmentos de linhas que foram formados
e apertando Enter.

¥

6- Clique com o botéo direito no icone hide para a férma aparecer novamente

X
=,.%/96,9,0,

7- Projete as linhas na férma utilizando a ferramenta Project Curves:

a- Selecione a ferramenta Project Curvesl o]
b- Selecione todas as linhas e aperte Enter

c- Selecione a forma do calgado e aperte Enter

O resultado devera ficar da seguinte forma:

8- Com a ferramenta Trim selecione a linha superior do calgado e corte a parte superior da férma:

a- Selecione trim, selecione as curvas superiores b- Clique nas superficies que serdo eliminadas
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c- A forma ficara assim

9- Selecione a ferramenta Split, e proceda da seguinte forma:

a- Com a ferramenta Split selecionada b- Selecione as linhas que irdo dividir o objeto e
clique no objeto a ser dividido e aperte Enter aperte Enter

Agora o calcanhar e a biqueira sao superficies independentes

10- Agora selecione as superficies da biqueira e do calcanhar e utilize a ferramenta:
Offset Surface. Essa ferramenta gera um solido a partir de uma superficie

Digite o valor 1mm e certifique-se que as setas estido apontadas para o lado externo da férma.
Caso nao estejam, clique na palavra FlipAll,
que se encontra na barra de comando como opgao para esta ferramenta:

Command: _OffsetSrf

Select object to flip direction. Press Enter when done ( Distance=0.3 Corner=Round Solid=Yes Loose=No Tolerance=0.001 BothSides=No Deletelnput=Yeq ElipAll )
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11- Selecione o corpo da sapatilha e utilize novamente a ferramenta Offset Surface.
Desta vez as setas devem estar apontadas para o lado interno da férma, e o valor € 2mm

Resultado
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SAPATILHA MOCASSIM

Vanilson Carvalho dos Santos
Tamisa Sheila Nogueira de Sousa

1- Abrir a forma no o Rhinoceros: File>Open>"Forma Tuto CG I1”;

| hew |

Op D0 e

@ THL 0 s D Hed IYE

save s

Seve s Temphote..
It e
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Espert Skl

Expert Witk Crngin..
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5o Tt Yt 3 e
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8 T L VANHWEE Docermenn FACULDADE COMPUTAGLO GRARCAFORMAS DE CALCADOS fusm. Werma 2idm
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2- Na Vista Right tracar as linhas sobre a forma com comando Curve: Interpolale points
(Iniciando e finalizando os pontos sempre fora da forma);
Clique com o botdo direito do mouse na vista Right> Wireframe ou X-Ray para melhor
ajustar o modo de visualizagao;

Fim Eft Yiew Cove Sufms Sdid Mok Dieanson Tamferm Took Sy Bwsde  Help
Hast poiet of paivine. Prass Entee woen dens | MisesLine Heperi=te Langtn Unsn ) -
Commanid CEE
2
Fe o LgE
Layors - A Layors a
GhrevsavPY
L) Mamms
L & L]
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3- Selecionar todas as linhas tragadas sobre a forma, com a ferramenta Trim, em seguida

delete todas as partes que ndo ira utilizar, depois apague também as linhas que ndo
serdo mais Uteis;

Sl cbject o . . o ] 13 =
DEESFXB0-~N PSP FTH=2 =57 AB000@ 85,0 A lmsnaed "He0 Pl
- Layers - All Layers a
BB wewaTHY

Hiam
pem s W

SADoRE Y
LR LR o

§

S G Clbw WM Clom b Cldwp Ol [0md Clbhm oo B S, ||
G amw g joawoam ey Tup OBe T Omep et Ty

4- Com a ferramenta Offset Surface selecione as partes que irad conter volume,
certificando que as setas estardo apontadas para o lado correto (todas para fora, se

ndo, clique em “Flip All”) e a ferramenta “ Solid” deve estar marcada, em seguida
aperte ENTER;

Cimating rastes_Frass Esciu cance.
Commant:

Sed [Ahew ClFwn WiWs Cce ¥m [CRep CiTe ofcus ik

Pt [ STk Dikstde
CPume (IS ySSTAST 20000 ame [

Snms Onhe P Owap  Recos Hawry
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5- Selecione a palmilha, e com a ferramenta Offset Surface dé um volume vertical para
baixo, utilizando as mesmas recomendacgdes do tépico anterior, digite o valor 3 e
aperte ENTER;

Fie B8t Vew Cuve Suleos Soid bwsh Dwaesien Tondoorn Took Anps Fasde  Help

Commani.
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T
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a
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6- Na vista Top, com a ferramenta Linha delimite o tamanho do salto;
7- Selecione a ferramenta Project to Surface, selecione a linha criada para delimitar o

salto, aperte enter, em seguida selecione a superficie do solado e aperte enter
novamente;

Fie G Yiew Corve Sufsce Soid Meh Omesien Trassiom Toots Sashse Render Hep

Comman |

FT »

B LS E Y

T ofiChsd et Profecs 1 57T 6 Cisabie |
Cune s20m  ymow 100 Wi hap  Onhe | Puns Csmap

8- Exploda a superficie do calgado, em seguida exploda a linha delimitadora.

File B Yiew Curee Suriace Seld Meh Omessin Trassform Toos Snchyes Rendes Hep
Undeing Deiwle
Command;

DEHETXR0 -0+ 0PpPH~sa -0 AB000Q "8L:0 (Il~sxcslHLoiGE
[ i

4, -]
3 U [ nwx TR
i ( : = Vigeesl
I — v W

FEm e P WL W et 10 vk Dt
CPane s 17048 y1ai 000 [t e Smp  Oahe Pune Ganap
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9- Selecione a superficie do calgado com a ferramenta “Split” em seguida clique na linha
delimitadora e aperta em enter;

He Bit Yew Core Sofer Sohd Meh Dmenven Toedoem Took Anaips feder elp
Undsing Deste
Command: T

—

]
§

Tk V%

Chane ¢183M  yBT0 =000 o Wl Snsg  Oftho Planat Canep  Recond History

10- Selecione a superficie criada e aplique Offset Surface certificando-se que as setas
estardo todas apontadas para fora e a ferramenta “Solid” digite valor 2 e clique enter.

Fie 2 Wwm Cune Swfss Sold M Dinson Tramfers Tooh Ay Recdsr Hiip
CNooss wotdoiew { Top Estiom £an Figh Front Bace Perspoctia | _Frost

e

DeEafxhd-~a f’ﬁfﬁ:qﬂ'fmég ABOODA THLE Elesespd B0 iPs
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11- Agora separe em camadas e adicione as cores e texturas que queiram nas
propriedades.

Tie T Mow . Dy Suaze| SR MY Serarebon | Tnibiom Tisle| Aastes: R | P
Fenger comisted e 000091

s o =
DRAxs~s Ty

M s
Lapr 02 L

[#E e it @ o Eie Ned@iSiwalivags |
yanam Winw @ Sap Odha Panse Osn  Record Histary

76



1- Vaem File>Open e abra o arquivo: forma de calgado 2dm.

2- Selecione a vista Right, e trace alinha superiore do calgado na fo rma,
utilizando control point curve.

3- Utilizando a ferramenta Curve: Interpolate Points tracar a parte de tras do
calgcado.




InterpCrv

Tbd Cldew Clfen CIMd Con [ ] 2 1 O [ Wt [ ot [ STenck ) D

J
efle ecee @ <

4- Na superficie do calgado , utilize Interpolate on Surface, para tracar as
linhas na superficie do cal¢ado.
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5- Para fazer o simbolo no meio do ténis, utilize a ferramenta Rectangle,
rotacione com a ferramenta Rotate, e depois projete o simbolo juntamente
com a parte de tras do calgado com Project to Surface.

!~ 7 Rectangle

|
’ [b i Rotate

6- Para cortar a parte de cima da fo rma, utilize a ferramenta Split, selecione a
forma aperte ENTER e alinha superior do calgado e novamente ENTER ,
selecione a parte que sobra e aperte DELETE.

Laerthe Rrinocerss
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7- Esconda as linhas guias, depois corte as partes de tras, da frente e a do
desenho do calgado com a ferramenta Split.

CELEAY
L § b

e Ulbew [Por M4 [

cRlereea @ 4 i

8- Para fazer o elastico na lateral do calgado, utilizea  Polyline para fazer o
desenho, Project Surface para projetar na superficie do calcado, e
finalmente a ferramenta Split para cortar e assim separar o desenho da
forma.

NeEaXD0~"+L LR Hee = aB3000@ "®1@
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9- Para dar volume ao desenho, selecione a ferramenta Filet Surface >Offset
Surface. Selecione as partes que deseja aplicar o volume , habilite FlipAll
para mudar as setas e deixa -las apontadas para a parte externa do calg¢ado,
e Solid para um preenchimento sélido, digite 0.8 para a espessura da parte
central, aperte ENTER. Na parte de tras e da frente seguir os mesmo passos
mudando apenas o valor da espessura para 1.5.

DEBSOIXD0~N+rR 0P TH=ecr8R000@ @50
| [Tee
h -

10-Para fazer o solado, selecione a  parte inferior do cal¢cado, e utilizando a
ferramenta Surface>Extrude Straigth, habilite BothSides=No para a
extrusdo reta ser apenas em uma dire¢do. Em seguida coma Curve
Interpolate Points navista Right faca o desenho do solado , depois
selecione a linha, utilize Split aperte ENTER e DELETE a parte que sobra.

DEE&FXD0~N +P 0P THme=0a0000@ 5,6
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11- Para cobrir a parte debaixo do calgado que esta vazada, utilize o Extrude
Straigth, habilitando BothSides=Yes, veja o tamanho certo e aperte
ENTER. Selecione Split e corte a parte que sobra.

12- Para colorir, crie algumas layers, divida as partes do calgado nas camadas,
colocando o nome de cada parte. Selecione a parte desejada e em cima da
layer clique com o botdo direito e selecione a op¢do Change Object layer,
selecione a cor ou textura de cada parte.

TG @

Layers - All Layers - B CommandH
DD xavw 4V

Zooms th
current v
and out.
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Resultado
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TAMANCO BASICO

Deborah Macédo dos Santos

APRESENTAGAO

Este tutorial explica como modelar um tamanco basico. As técnicas aprendidas nesta
modelagem podem ser facilmente aplicadas na criagdo de diferentes tipos de saltos.

TUTORIAL

1. Como trabalharemos com um desenho de escala maior, o faremos em
centimetros. Este template pode ser selecionado ao abrir o arquivo, ou em
“File”>"Propreties”> “Units” > “Model Units: Centimeters”

2. Inicie maximizando a “Viewport Top”. Vamos usar um “background”, assim
ficara mais facil tracar as primeiras linhas no computador. O “background”
pode ser scanneado, fotografado ou coletado da internet. Seja como for, ele
deve ser salvo sempre como uma imagem em formato “JPEG”, “TIFF”, “PNG”

ou “Bitmap”. Para inseri-lo, va até a barra de menus, clique em
“View”>“Background Bitmap”>“Place”.

3. Apods clicar em “Place”, uma janela chamada “Open Bitmap” surgira. Encontre
o arquivo “Sandalia-02” (faga previamente este desenho conforme a ilustragéo),
clique sobre ele e clique em “Abrir”. Na “Viewport Top”, digite “0” na linha de
comando, tecle “Enter” para confirmar, digite “23” na linha de comando e tecle
“Enter” novamente. Isso fara com que a imagem de “background” fique

alinhada no ponto “0” da “Viewport Top”, isto €, no cruzamento dos eixos “X” e “Y”.
Posicione a “Viewport Top”.

4. Para iniciar o desenho da sandalia, Clique na ferramenta “Curve” e em seguida
em “Curve Interpolate Points”. Na sequéncia, clique na base da sandalia e faca
novos cliques acompanhando o contorno do desenho como mostra a figura.

Clique com o botao direito do mouse para terminar.

NS i Curve
oo JI@rado
;F‘i bu 8 Curve: Interpolate Points :{:
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5. Agora que toda informacao necessaria foi retirada do desenho, va até a barra
de menus, clique em “View”>“Background Bitmap”>“Hide”.

6. Clique duas vezes na vista “top” de modo a visualizar as quatro vistas. Note que
o desenho esta todo no mesmo plano.

7. Para rotacionar o desenho inferior vamos utilizar
a ferramenta “Remap to CPlane”. Selecione o
seu desenho inferior, depois selecione a
ferramenta “Remap to CPlane” . Entdo dé um
cligue com o mouse na vista “Front”.

8. Na vista “Top”, selecione a imagem de vista superior da sandalia e, com a
ferramenta “Move” movimente-a para que fique alinhado de acordo com o desenho
abaixo.
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9. Amplie a vista “Perspective” selecione a ferramenta “Curve from 2 views”, e
selecione as curvas 1 e 2 conforme ilustragéo a seguir, a fim de formar o plano da
parte superior do solado desta sandalia.

EU%ITX B~ PO H=-Cr0 600008 450




10. Note que o desenho que fora a base inferior do calgado n&o termina no mesmo
ponto do fim do salto. Ligue a ferramenta “Control points On” l‘ e use sua
criatividade para ajustar esse desenho. Pode utilizar a ilustragdo a seguir como
referéncia.

11. Amplie a vista “Perspective” selecione a ferramenta “Curve from 2 views”, e
selecione as curvas 1 e 2 conforme ilustragédo a seguir, a fim de formar o plano da
parte inferior do solado desta sandalia.

12. Crie uma nova camada, chamada “linhas-guias” DESLIGUE-A e coloque |a as
linhas que nao vai precisar mais.

13. Caso as duas curvas laterais que desenhamos no iniicio ndo estiverem
terminando exatamente nas duas faces que fizemos, ajuste-as manualmente com a
ferramenta “Control points 0n”3|na vista “perspective” com o “near” do “snap”
ligado. Mova os pontos pressionando a tecla “Ctrl” quando necessario, de modo que
figue como a figura a seguir.
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14. Clique na Ferramenta “Sweep 2 rails”, clique com o mouse nas linhas 1, 2, 3 e 4
conforme o desenho abaixo, clique “enter”. Aparecera uma caixa de dialogo
intitulada “Sweep 2 rail options”, marque a opgéo “Closed sweep” e clique em
“preview” para vizualizar como ficou o desenho.

15. Note que as linhas verticais ficaram muito inclinadas, para alterar isto, ainda na
caixa de dialogo clique em “add Slash”. Em seguida cligue em pontos para formar
linhas verticais conforme o desenho abaixo. “Enter” e “Ok”.
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16. Habilite novamente a camada das linhas guias apagada. Selecione as duas
curvas selecione o comando “Extrude Straigth” . Na linha de comando, habilite
“BothSides”. Mova o cursor a fim de cobrir toda a envoltéria do solado e clique com
0 mouse.

NeE@8Fxh0~N o decH= i AaROCEe® TE5.@




17. Desligue a camada das linhas-guia novamente. Selecione o comando “Split”,=E
selecione o plano que ira ser cortado, clique “Enter”, selecione a curva do formato
da base do calgado, clique “Enter”. Selecione o e clique em “Delet”.

/’

=

18. Para finalizar o tamanco, faga dois arcos
com a ferramenta “Arc: Start, End, Point
on Arc”. Faga uma linha unindo os dois
com o comando “Line”. Cire uma face com
o0 comando “Sweep 2 rails”, conforme feito
no passo 14 deste tutorial.

Arc

| O Arc: Start, End, Point on Arc
_ | ® Arc: Start, Point on Arc, End

88



MODELAGEM TAMANCO ANABELA

Fernanda Kelly de Araujo Ribeiro

1 Crie uma linha de referéncia com a ferramenta "Line", em seguida projete -a
na forma usando a ferramenta "Pull Curve to Surface".
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2 Para dar inicio ao cabedal, faremos trés formas geométrcas, um retangulo
com a ferramenta " Rectangle: Vertical", um poligono com a ferramenta "
Polygon: Edge" e outro retangulo co a ferramenta " Rectangle: 3 Points". Para
formar uma pega Unica, deve -se cortar a unido entre as formas com a
ferramenta " Trim", apés, selecione todas as linhas e dé um "Join".

DS B sBe
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3 Para conformar o cabedal na forma utiliza -se a ferramenta " Pull curve to
surface". Selecione todas as linhas tecle " Enter" clique na forma e tecle "Enter"
novamente.

e

Commana: SRR

7D,_E‘I3K RO~N 3PP APEH=a-7702000@ T®LE

3  Layens- Al Layens B Command Hep @
(Y DR xavaTAT
accet — oaa] e
joilc) [ |
o Ve
nio ol 1 | Undocumented
@ This topic has not yat baan
wracaed. TS M Amoumn
g9 camas rem Post questions about this
oign tsm command
b4 = HH LIPS
5@ CalR
e
b = i
LG Lot L]
apecnl veam
3 =
— O
tsm
;; = rsm
[
=] =

Flon [l Flfwp (1T ] Oumd [ ou () Prect B STroch() Dusble

How
CPaoe _s-i0188 __y 1935 o am WMo Snsp  Orths Plansr Oup Recsed Hatory

4 Para formar a tira do calcanhar usar a ferramenta " Line" , dar um "Join" para
uni-las e conformar na forma com a ferramenta " Pull curve to surface",
seleciona todas as linhas, tecla "Enter" , clica na forma e tecle " Enter"
novamente.
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5 Para preencher o cabedal faga linhas na vista Top com a ferramenta Line.

% sapatp de kelly - Rhinoceros (Educational Lab License) S T |

Fie Edt Wew Cuve Suface Solid Mesh Dimension Tramsform Tools Analyze Render Help

=.§m::inau into ane open curve, :!LU ﬂjl
__D|EU&ET>< DO~ 3 PHPPPH~2-§8B000 T®5 @
&l Superior erspectiva Layers - AllLayers x

Derecha

QEFS e bhELQHQVQT
E UL Qo] '

|FEnd [P MNem Pont TMd ["Cen it [ Peap I Ten [ Quad I Knot Jﬁ*u.sr:u_}nm]
CPlane  x-22.530 ¥-9.906 20,000 0.000 | Snap | Ortho | Planar [Osnap | Record History

WMostado
i miciar| 5 Nova pasta ]ﬂup.mdem-mm_ ﬂmww-moso& ‘ 29 133

6.Com “Pull Curve to Surface” selecione essas linhas tecle Enter, clique na

forma, e t ecle Enter novamente. Deslique as linhas que foram feitas com a
“Line”

Transform Tooks Anslyze Render Hep.

. Press Esc o cancel =
Commanud: =[]+

FEREILRNE e

Persp

[FEnd FMew [Pont [ Md [Cen [ [ Pep [ Tan [ Quad [ Enot _|Poject I STiack _|Disable |

[ Ptane  x-9.673 ¥ 0.629 20.000 == [Soap [Ortho [Plan= [Osnap | RecordHistary
A tnictar] j Novapasta 3 sapatp de kelly - Rhin... (W] Documertol - Micoscft . .\ 20 2%
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7 Com a ferramenta “Patch” clique nas linhas do cabedal tecle Enter e em
seguida OK.
% sapatp de kelly - Rhine {Educat se) AL

Fle Edt Miew Curve Suface Soid Mesh Dimension Transform Tools Analyze Render Help

Select curves and points to fit surface through. Press Enter when done: =
k______ EOID

DBE8CX D0~ 3PP PP H=GCE TEB5; @

Superior Perspectiva

Staring sutace gl [
I~ | Preseve edges
I Delete it

Gl e RGO IO G -

?EWJQ&QWO&@V@?V

2

|WEnd F New [ Pot [ Mid [ Cen [ It [ Pep [ Tan [ Qusd I Kot _|Pioject B STrack _|Disabie |

[ crane x15.657 ¥ 26,225 20,000 0.000 [Mostade [sosp [ Otho | Plensr | Osnap | Record History
A Iniciar| ) Nova pasta 3 sapatp de kelly - Rbin... [W]tutoral kelly - Merosctt . n‘ 29 30

8 Para fazer o corte da malha use “Trim”, clique na linha do cabedal, tecle
Enter e depois dé um clique na malha fora da selegdo. Faga o mesmo com a
frente do cabedal e as duas tiras.

% sapatp de kelly - Rhinoceros (Educational Lab License) T Lleix]
Fie Edt View Cuve Suface Sobd Mesh Dmenson Transform Tools Ansiyze Render Help

Command. _Gancel =
Eommn EiD|

DoEdXD0-~N RS 0P H-x«>r?88000@ "&1:@

Superior Perspectiva Layers - AllLayers
o

l

Lokl (CEVE = JORVAC lr g
RO IUGH
5,0,0,0,5, 0,5, 5,0

8 Tiim Derecha
B Undiim Surlace)

|PEnd R New [Pt T Md [ Con [t [ Pep [ Ton [ Qusd I Kt _|Piopect B STiack _|Dissble |
CHlane  x -24.03% ¥27.899 20.000 | WMostade ['soap | ortho | Planar [Dsnap | Record Hstory

@ niciar| j ovapasts |/ sapatp de kelly - Rhin... [W]tutseial kel - Miarosate . | .| « 13:49
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9 Na vista Right faca duas linhas retas com a ferramenta "Line", use "Arc: Start,

End"

linhas

"Direction at Start" para unir, também, as duas linhas.

=l8(x]

Click and drag 1o pan { Down Left Right Up In_Out):

b= |
Command: | =0
D& T X ﬁﬂﬂﬂ#ﬁb]ﬂﬂﬁmﬁae‘?ﬂ? 8BO0C0R "1 @

Superior uy-um.,-s—x
OB xavrq4TP

g
=}
g
g
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&
g
&
&

QHWJs&#m@kmv@?V‘
[ §%le hif©o 0 .911\“

IFEnd @ Mea [Po ["Mid [ Can [t [ Pep [ Tan [ Quad [ Enat I Project M STrack _| Dissble | ' -
| Plane x6.797 ¥ 3%.167 20,000 0.000 |WMomade [ Sowp | Ortho | Mawr |Osnap | Record Hstory
@ niciar| | Nova pasta 15 sopatp de kelly - Rbin... Wi ttorial el - Micoscit .. | .‘m
10 Crie uma malha com a ferramenta “Sweep 2 Rails”, clique em todas as
tecle Enter e depois OK.
Dimension  Trarsform  Tooks Analyze Render Help
section curves. Press Enter when dane ¢ Point ) =
EQID|

[P Tp——
DR xavrdTRP

I Frosoee fast shope
I Preseve Jait shece
T Maintain height

rEnnI!'sme ﬂ' 777
o | e |t | [

FEnd FHew [TPort MMd MCen Mt CPep Tan [ Gusd Kot les'n.ac_lm\

Tl x5 yoam | 100m o o
2 tnictar| | tiva pasta k5 sapote de kelly - Rhi,. (W) tersl ey - icrosoft . [« w2

11 Crie uma linha de referéncia com "Line", Ortho deve esta habilitado, na linha
de comando digite “10” e clique no ponto. Para desenhar a meia pata, use
“Retangle: Corner to Corner" na linha de comando digite “8” tecle Enter, depois
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novamente tecle Enter.

% sapatp de kelly - Rhinoceros (Educational Lab License)

Fie Ede View Cuve Suface Scid Mesh Dmension Transtorm Tools &nshze Render Help
Click and drag to pan ( Down Left Right Up In Out):

Comuman

=
nd: | T
Eﬂ&ﬁX@DBﬂ@ﬁbﬂBSE‘Q@?Qﬂ!OOﬁO‘@%O

Layers - All Layers == X
DB xavw « ¥R

DENS 0 bB0OEIVAY 7D
[ §%le hafQ@9I0 60

o ]
FEnd FMHew MPont MMd MCen it T Pep T Tan [ Quad I Knat ,JPM.STTI#.,JDW‘

CPlane  x21.906 ¥ 160,120 20,000 Wrostsdo Snsp | Ortho | Planar | Osnap | Record History

B nicior]| (£ Nova pasta = “Rbin. (0] kil hely m| « 145

12 Trace linhas com “Control Point Curve” e “Line”, na vista “Top”, em cima da
palmilha para meia pata.

sapatp de kelly - Rhinoceros (Educational Lab License)

AL TES |
Fie Edt Vew Cuve Sutoce Sobd Mesh Dinenshn Trangom Tods fnoze Render He

2 curves joined into one closed curve =
Command: =TT

5@53X®ﬂﬂﬂ@ﬁ@ﬁ@$$*g@?9EDOOBO*@%O

QHERI e EBNOHEQVAT 7
P %42 h&§@0 N0

(M End P Nes [ Poi [ Md [ Cen It I'P!ln I'I'm I Quad [ Knot_|Priect I STiack _| Diseble |

CPlane x-35.145 y19.075 20.000 ["saap [ Ortho [Flaner [Dsnap | Record Hstory
@ tniciar| 3 Wovapaza i3 sapatp de kelly - Rhin... E baly -Microsatt . H« s
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% sapatp de kelly - Rhinoceros {Educational Lab License) 1 &) x|

c.;?:.T:.TL: iuuﬂi'
| BSTXRO0~N+RPS0RSH2ecrPaB000@ "&5H:@
Pe Layers - All Layers. x
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[~E [hame [T [T 1]
Mostado v ]
foima [ N}
D lichateteren..  § '
linha/csbedal @ £ H
o me §o8
'; 1 |;':i;|mu L =]
(= )] Lam Pom
i b pal2 egm
O& r:nm : g:
S FrR b
| | aes 8 25 o]
YEN
3
T
a0z
&
= T R |
_]Eind WMem T Pot TMd [T Cen it [ Pep I Tan [ Qusd [ Knot Jn@ansnn_jnm\
[cPlane  x-24.637 ¥ 14.680 20,000 0.000 WMostado [Snap | Ortho | Planar |Osnap | Recoed History
Hmﬁ-l () Nova pasta "m Emwhly-namft ﬂ] « 14:59
13 Usando “Line" crie uma linha para unir as figuras. Com “Sweep 2 Rails”,
cliqgue em todas as linhas tecle Enter e em seguida OK.
kelly - Rhino (educational Lab License) BT

Fle Edt View Cuve Safsce Soid Mesh Cimersion Transform Took Analyze Render Help
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I Dosed Add Slash
= MR T
o= | e e |
i)
|FEnd [FNear [Fort [Md [Cen [l [ Fep [ Ton [ Qued I Krot _|Froject I STiock _{Disobie |
CHlane %6552 ¥1.185 20,000 0.000 | mostado Snzp | Ortho | Fanar Osnap | Record Hstory
@ tniciar| 3 Nova pasta K38 sapatp de kelly - Rhin_. W] utoria bely - Mirosost .. | [« =m0

14 Na vista Top use "Extrude Closed Planar Curver" para dar volume, clique na
linha interna tecle "Enter", na linha de comando digite “0.3” e tecle "Enter". Na
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vista Right mova a figura um pouco par baixo, pois sera o antiderrapante do
sapato.

15 Para finalizar o salto, desenhe um retangulo usando a ferramenta "
rectangle”, na vista Top, para dar volume usa -se a ferramenta "Extrude”, na

vista "Right", use " Split" pa ra retirar os excessos e a ferramenta " Loft" para
unir o salto.

Resultado Final




SAPATO FEMININO COM SALTO

Yagara de Lima Alves
Julia Alexandra Ramos Silva

1. Abrir o Rhinoceros, selecione a escala em centimetros.

3. Na janela View >blackground> Place.
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4. Escolha o arquivo VISTA SUPERIOR PRETO, e clique em abrir, digite 0,
ENTER, 55, ENTER.

5. Com o arquivo aberto, selecione na caixa de ferramenta
CURVE>CURVE:INTERPOLATE POINTS.

AR B AR RG
kG bR

6. Com a ferramenta selecionada, faga o contorno da palmilha maior do
calcado, e crie uma camada.

DN @ LBPOREVGT

?
&
¥
“
-
E
5
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7. Repita o processo 5 e 6,para criar a palmilha menor, criando também uma
nova camada para a mesma.

B o Gy ot Sobs M Drran Tomwtom Tor e R b
e ot s e D= Kaan-Crss EnTege Chse. (e U ) :
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8. Minimize a vista TOP, e maximize a vista FRONT.

.muucx QO-~0 420 HRTH= - r vnuoaqu‘n'ull

"RGVAT @
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Listen

LN

DR o B
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10.Abra o arquivo Sapato alto, localizado na area de trabalho; , e clique em
abrir, digite 0, ENTER, 55, ENTER.

e T

DAL B EAE
(IR

11.Com o arquivo aberto, selecione na caixa de ferramenta
CURVE>CURVE:INTERPOLATE POINTS, e delinear a parte superior do a
plataforma, e da abertura superior da plataforma.
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12.Caso as linhas estejam desalinhadas , selecione a ferramenta SCALE, para
alinhar as mesmas.

Y AT E R P P E T P Y 11
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&
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a

13.Selecione a ferramenta SURFACE>SWEEP 2 RAILS, selecione as linhas
criadas no contorno inferior e da palmilha maior, para criar um tipo de
palmilha curvada; repita esse mesmo processo com a linha superior e a

DRI P LIEOMG TS
| Yoo ikhes el

palmilha menor, para criar a abertura superior.

14.Selecione a ferramenta CURVE>CURVE:INTERPOLATE POINTS, criar a
linha do cabedal e do calcanhar.

OOmf e AL AATH=» F70B0008 1D Jaud:x DOnd s pLAATHE=~-F ¢ 230000 T8hy

LS

15. Selecione a ferramenta SURFACE>SWEEP 2 RAILS, selecione as linhas
criadas pelos passos 13 e 14, para criar solidez na lateral do calgado.

)
al-'

DA B ESLOAT
| e iR

WA RSO RI TS
Liave bEbtedl
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16.Vire o calgcado para o lado esquerdo na vista Perspective, para criar o
mesmo processo realizado no passo 17, nesse lado.

QAL 0 R0
(R EY AT

17.Selecione a ferramenta SURFACE>PATCH, selecione a palmilha curvada,
para dar solidez na parte inferior da palmilha.

&

AR BEATO NS

18. Selecione a palmilha criada no passo 17, posteriormente selecione a
ferramenta TRIM, clique na camada LAYER 10,para corta a parte que esta

passando da palmilha.

o
*
2

iSO RIUORG TG L prd
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20. Selecione a ferramenta SOLID>TRUNCATED CONE, posicione abaixo da
palmilha; digite 2.5 cm para parte superior e 1 cm para parte inferior; e
digite ENTER.

DL B AIBENGT O I

Lba ik

21.Clique no parte superior do salto a qual esta passando pela palmilha;
selecione a ferramenta TRIM, clique na palmilha para seleciona—la como
objeto cortante e clique em ENTER,para finalizar o corte

IR TP

22.Clique na ferramenta PROPERTIES, para iniciara RENDERIZAGAO, clique
na bolinha branca que aparece na lado direito.
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23.Selecione as cores, ao selecionar as cores digite ENTER, conforme
indicado para finalizar no processo, e escolha as cores de sua preferéncia

24.Clique na ferramenta RENDER e ai sera gerada a imagem renderizada

Chuna T2 y22I0 o0 ] oo
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Resultado
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MODELAGEM LOGO TIME DO FLAMENGO

Rhuan Naué Leite Pereira

1. Abra um arquivo novo no Rhinoceros.
2. No menu View > Background Bitmap > Place
selecione o arquivo CFR.jpgDigite 0 e determine o tamanho que a imagen deve ter(imagem1 )

File Edit Curve Suface Sofid Mesh Dimension Transform Tools Amabyze Render Help
Loadin Undo View Change Home
[Comman: Redo View Change. End : A
08 o swe [PEHescr9AB000@ "85
T Rotate Cirl« Shift+ RME.
Zoom (3
N sever *
@,@ Set CPlane 3
I>;§D' Set Camera 3
@’, "1 Viewpart Layout »
| Active Viewport >
:3 Page Layout »
=5 Background Bitmap. v
g: Grid Options...
Capture .
‘:g B Close Viewport
B A . visame
" Shaded
T Rendered
Ghosted
o8 Iz
| X-Ray
Q.—, Fiat Shade
Shade Selected Objects Only
Remesh
Display Options.
Viewport Propertss...
+ [l v

FEd Cltesr Clfort CIMd #Cn vt Dfep DOTon 0w DKot [ Froect [ STack () Duate |
Place 3 background image in this viewport imagem1

3. Usando a ferramenta Curve: Interpolate Points contorne todo o desenho (a dica é: termine
uma linha a cada quina do desenho e com a opgéo end selecionada recomece com uma nova
linha de onde parou). (imagem2)

ki s i i o b im0 ok sl e

Commang. _InterpCrv
‘Start of curve ( Degree=3 Knots=Chor StadTangent ) e

DBHETXDB0-~8+25 0P FH-«Cr 0 A3000@ T85:0

DEFL O LELORVA:

P
&
©
*
£
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o
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Cltesr Clfat ClMg e [let  [CPop DT [Cowd koot () Prosc ) STack[Dostle |
CPlane x-6.55 yEA 2000 WOt Snsp  Ontho Plansr Osmap  Record Histary
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4. selecione as linhas e clique na ferramenta join, ela unificara as linhas que se tocam
formando uma s6 identifique as pegas que formam cada letra, separe as parte em camadas
e selecione as cores coforme a imagem ao abaixo. (imagem3)

File Edit Curve Suface Sobd Mesh Dimension Transforn Tools Analyze Render Help

Command. _Cancal -
Command: e »
DeE80XD0~N+LPLHRPF B e« 7aR000@ 7016
X Layers - All Layers.

I e DR xavd4dTART
N [ Mte]
@ Defat 1am

L0l v O
B> w2 9
@
¥
@

L F—TT— »
[ FIEd ClNes ClPort CIMd FCn [k [FPep FTon [Oued Fkat [ Poject [l STrock[] Dissbie
CPlane x2410 y031 2000 000 OLayertl Snap  Ortho Planar Osnap  Record History

imagem3

5. usando a ferramenta Extrude Closed Planar curve digite 2 selecione cada uma da perte
e dé enter faca isso com todas elas. (imagem4 )

s phummep fucscepiiobl s Mt e e sy Tonir i b anbnbie
Selectcmes i Exbuse_Pouse.
E=3

e by Flfoe CMs Bom Cm Flfep DT [ D [ Pugen ) Stox] Dt
e T ] o DOt Sap O Planw Ouwp  Sacond Hetomy  Seec tmmt L Objchs

imagem4
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6. Reorganize as parte em camadas separando as linhas dos obejetos extrudados e selecione
as cores coforme a imagem a baix@imagems )

5 Untited - Rhinccercs (Educationsl Lab Liense) - (Perspective] - . il S

Command: _shage :
- Choose Shade settings ( DisplayMode=Shaded DrawCurves=Yes DrgwiVires=No DrawGid=Yes DrawAses="es ) | e

DeE&afXD0~+A0 0P H-«r PaB000R 870
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CPlane %9633 yBAL 2000 Wlayer02 Snsp Oftho Planar Osnap  Record History
imagem5

7. Esconda as camadas dos objetos e deixe visivel apenas as linhas.

8. Usando a ferramenta pipe Flat Caps digite 0.5 selecione uma parte e dé enter (faga isso
com cada parte do desenho até que fique igual a imagem) (imagemé )

5 CR¥ - Rhinoceros (Educational Lob License) - [Perspective] - ¥ o3

Comma Curves=7es Drawiies=No DranGid=7es DrawAies="es ) CED
DeESTX00-~N+A5 0P H-«:r 7 09000@ 8071:0
Layers - &0l Layers
R DB xavTA7?
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@ Fl Objsto cdm
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CPlane x-5241 ¥1248 2000 00 Wloyer02 Snep Otho Planar Osnap Record History
imagem6
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9. visualize todas as camadas novamente, e The End.

5 CRF - Rhinoceros (Educationsl Lab License) - [Perspective] - = on
File Edit View Curve Suface Solid M Dimension Transform Toels Analyre Render Help
- Command._Shade

- Choose Shade seftings ( DisplajMode=Shaded DrawCunves=Yes Drawiires=No DrawGrid=Yes DrawAses=ves e

NeE@80x00~0+L,50RpFHex27P0B000@ T®5,0

Layers - All Layers i G
BB xavr«TH7

E ¥l FRQ®D IO G
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CPlane %5602 1046 2000 W02 Snop Oftho Planar Osnap  Record History
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MODELAGEM DE CASTICAL

Jonas Alves T==Zeixeira

1° Passo : Crie o esbogco da peca na vista Front com as medidas
especificadas na imagem. Use as ferramentas Arc,start, endradius, e a
Polilinepara a construgdo do esbogo. OBS: Lembre-se de clicar para concluir o fim de
uma linha e enter para terminar o comando.

2° Passo : Importante : Selecione todas as linhas e clique na ferramenta Join.
Assim o seu esbocgo ficara totalmente definido para a construgéo do objeto.

e I |
BN
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3° Passo : Utilize a ferramenta Revolve para criar uma revolugdo através do
eixo Y com 360°. Selecione todas as linhas do esbogo, cliq ue em revolve,
enter, acione o end point da barra de ferramenta osnap, clique no end inferior
da linha vertical de dimens&o 220 e depois no end superior dessa mesma linha,
enter, enter. Use a ferramenta Shaded viewport para visualizar as superficies
criadas.

g9 T W Y. T m  Mesh Todls  Render Tools
e‘o‘:\) - B ron NE 0 thad ‘E ﬁ I—n
SETEINLE DO e L

) Shaded viewport
) Wireframe viewport

4° Passo : Na mesma vista frontal crie um novo esbogo com as ferramentas
Arc, start , end point on arc e Poliline, conforme imagem e medidas
especificadas abaixo.

7

A Vl j - :
=S .:E.rl 2 lg:,, B ¢l Endpaint object snap
8 f ® Ral revolve

B Polyine

@ Line seqments

5° Passo : Va para a vista Right e crie uma elipse, from center comegando no
end superior da linha de medida 10, com 5 de espessura por 17.5 de
comprimento. Isso quer dizer que teremos uma elipse com 10 por 35 de
medidas. OBS: Imagem abaixo.

6° Passo : Va para a vista Perspective, selecione o esbog o que servira como
caminho, clique em Join, depois clique na ferramenta Sweep 1 Rail e depois
clique na elipse, enter, enter.

ey T M

A
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7° PASSO : Va para a vista top, use a ferramenta Circle:Center, Radiusclique
no ponto central superior do objeto, digite 30, enter. OBS: Para pegar
exatamente no centro da parte superior, a opgdo Cen da barra de ferramentas
Osnap tem que esta acionada. S  elecione o circulo, clique na ferramenta
Extrude Closed Planar Curve, digite a letra B para acionar a opgao
Bothsides, que di reciona a extrusdo para os dois lados, e digite 15, enter.
Cligue na ferramenta Boolean difference , para subtrair um sélido do outro,
cligue no objeto principal, enter, depois clique no solido que vai ser removido,
enter. Selecione o sélido a remover ,e delete.

A 2 Y
K: K_); .CenD\mDPemDTar gggggadq&ja =

|B Qrcle:‘center. radius | imel e PeGGm f & @E;%:& %E[;
= -“-T__'_-_'.__.: _,__ VT, 1 Btrude cosed planar cuve (9 S & IE@ L]

\
s - Antes:Depois :

8° PASSO : Continue na vista Top, crie um Arco e uma linha com medidas
iguais conforme imagem abaixo. OBS: Use a ferramenta Lenght para conferir
as medidas. Use a ferramenta Text Object para digitar o seu texto ea
ferramenta Extrude para criar o sélido do texto . Selecione o texto, clique na
ferramenta Flow Along curve, clique na linha e depois no arco.

W % / S Yl A 6,8

ssa@ - |ﬁ@|n,p S%D% o % &

oo, My T‘R @ G Length ;' a,’; P F @._; ggg ;; = H «§ [IE
» @ Domain 8

a, QIv, :ﬁ:m% K Text object ﬁﬁflc/\www

e (S 0, *|g; o rmeses]

9° PASSO : Clique na ferramenta Shaded Viewport para visualizar sua pega.
Aplique um material. Selecione toda a peca, clique em Material, selecione a
opgao object, selecione um objeto, e clique em abrir.

Mesh Tools ' Render Tools a———

|§i@. @, e,

“gg.
B Shaded viewport @—& &
B Wireframe viewport N i
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MODELAGEM DE UMA MANDALA

Gleciely Jorge de Almeida
Francisco Luiz das Neves Bezerra

PASSO A PASSO:
Abra um novo arquivo no Rhino e escolha o template “Small Objects Millimeters”.

1. 1 MREDAN M BBEOGP 11061 BMONG MG M@ENRNEE

2. F@pN OMNEM MRIRO NVNRO OGP iiO 6T ANOON‘Background Bitmap”:
“Place” e importe a imagem.

3. F@pN N M@@ OOPREGMPmdd N MYNOB

4. [ M NEBM NN NNGGMONERADEnap: Center object snap”.

2,

Perpecte | Top | Freet | Right|_&
7] End 7 Haa (7] Pors (71 A0 7 6L5EM PBCU IR Jy o ) 7] it 7 i ] Pt (] Dl
crana | sz | ydoum | zoow | wmmenrs o

Gns nap | oo | Pianar | Osnap | smamiracx | Gumeal | Recoravestory | Fter |mnutas wom i3zt save 2

5. INGINOON MNGBMONOEiMIE: Center, radius” e faca todos os circulos do
desenho.
B s et 167 e ot - o

Ve e Vem Guve Sufse Sok) Men Dwmmson Tondom Tods Arege bmde el Help
ot cops 0 FromLasiniotis st astistamca o Lol alisctionhin )

1 il

camnant:|

i Tt Corv Tosin Sca Tl ek Tocn | Mo Tots e Tach | Criirg w5

o | Chs S D S S Ly
DEES0 XD 0~N + 2000 EH ®0 00 TELE

P [ e s ] ] vt o (] e
Crane | x| yasos | oo | wemens |goswr Gratnm O s | e | Smadioa | Gumeat | Recwbsbn | Fae

6. | @ M NNG@MOROeMrol point curve: Curve through points” e faga o contorno
do desenho do primeiro circulo.

ey ]
Fie G Vn G Gaface Sovd M O Tandeen Tods A e S oy
1une ameats B
Comman: =
S CPars Setien gy St Vgt oyt iy Trrwom o o e Tol Sl ok Mo Tl oo Tols Dby o ' (-]
B0~ +po0 2T HS®CE

9.0.2000@ w50,

o (v [ Fom ] Ton ) hne ] bt ] Vo ] gt [ Dt
0 n

rsn | room ey oetoun Gnasnap | Omo | pimar | Osnsp | Smarirock | Gumsal | Recom s | Fe
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Fa@ppRN 00 NOOPOBOO @bN MM NMRNEBED NbFQM N ONSGNIN
comandos digite “Array Polar” e tecle ENTER. Marque a opgao “Center” na

barra de ferramentas para localizar o centro do circulo, digite 4 e tecle ENTER
trés vezes para que o desenho se repita.

Fie Edit View Cuve Suface Soid Mesh Dimensien Transform Tools Anabze Render Panels Help

[ farer tutorial (157 KE) - Rhinoceros (Fducational) (62-5i) - Top] i L= | ]
Press Enterto sccept Fillangle = 360 (Rems=4 Fillangle RotatesYes ZOfsat=0 & -
@

DEFI o AEDOROVAT T O
Snl3=E §Hl e FRESH I N0, -

g

-

i
Lt
§

Pe [ Tan () usd [ Kot [7] Vet ] Proect () Dltie
20000 | Milimeters | EOsfaut GridSnap | Oriho | Planar | Osnap | SmarTrack | Gumbadl | Record History | Fiter CPUuse 35%

ININOORNa ferramenta “Polyline”, ative “Osnap: End” na barra de ferramentas
e ligue os pontos do desenho, selecione todas as curvas que foram feitas e
clique na ferramenta “Group” para agrupar.

E-mvmcumswuwmnm1mhm~w-nmd-mm’

% Uniitied - Rhinoceros (Educational) (54-bit) - [Tap] E E o el
Start of polyline { PersistentClosesNa ) -
Hext point of polyline ( E6ceistenICios e=No Mode=Line Helpers=No Unda ) &

@

Transbom | Curve Tools | Surface Tools | Solid Tools | Mesh Tools Render Tools | Drafing | Newn' |

Stadut | CPlanes | SelView  Displey  Seect | Voewpert Loyt Vit
DeEaxhi~f+2 50 H= 77009000 85,0,

[
a
a
]
El
@

| | Viewport
Tee Top
Wt no

X Target 1500

Yo 4sn

T om0
T locwen [P
af S | I T Walpaper |
EL I EE] i .
Te |
Qf D‘mum Top | Front | Right | & | |

] End [ Moar [7] Poit [71 Md 7] Can ] it T Pem ] Tan 1) Guad [ Koot 7] Metex [] Prasct (1] Dreatle
CPlane |  x-0.158 ¥5558 20000 | 0408mm |EDefaull GridSnap | Ortho | Planar | Osnap = SmarTrack | Gumball | RecordHistory | Filer Available physical memory. 343 ME
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INGINOON MNBGMONGRMve” e faga o contorno do desenho da parte de
dentro do segundo circulo, ndo faga o contorno no desenho, deixe que a curva
faga no centro do desenho como mostra a figura abaixo. Selecione o desenho
que acabou de fazer e na barra de comandos digite novamente “Array Polar”,
tecle ENTER, encontre o centro do desenho, digite 8 e tecle ENTER trés vezes.

8 Uit - Bvinoceras (Ecucationa) (64-b4) - o] 21 il

Fie Edt Wew Curee Sufsce Solid Mesh Dimension Tuntorn Tools Anshae Render Pansts Help
1 curve added fo selecion

Command: Ara TR

S [T ek Dl e porlsut Vil Tovsrn | i Te S Tooh | T Mo TocFarsarToon | Dt w5

0 & e, RO+ LS OREH- % ,570,92000 VWL,

B oo Notes Y NEpaEr EE, JRERS E T amar |30 R
e : L _an ! g

L&, i HRH 7 Dbt
i RERS . il = iEams =
chet | I . Layr
Z9, ; i
X o T TP pracar
S&, W Ty | | -
Bl 1 R e S
B z |
a5 e | P | seoon
T HEEEHEEH R |l
T ! —
B : - _— ;
9‘.“" IR e Shew satace. :
g g F T N 4 1 | —v—|
G.v, ! ! N [ pea. ]

JB ! - L I Y, A

o T

1 End [ Mear 71 Pt [ M 71 Cen [ bt [ Pew 71 Tan [ Qusd [ Knot 7| ertex (] Provect [ Desaie:
CPiane ranEs | yaaez |_zomo0 Milimeters [ Detault GndSnap  Odho  Planar Osnap  SmarfTrack | Gumbat Filler _Memory use: 128 M8

. ING®M O OB 6GONREEIMPM O NGED Nvi GM@BPR NN NNOPH
digitando dessa vez 30 que é o nimero de copias que serdo feitas, e
desenho da parte de dentro do quinto circulo digite 12.

o O
=2¢
[N e
° s
2
&
o
O«
2>
=3

3 faze i (67 K8} - Ainoceros Eucariomst (641 - Topl loe .

Fle Edt Viem Cave Sufse Sohd Meh Dmendon Tamform Took Anshe Render Panes Help
Press Enber o accept FillAngle = 360 ( Rems=8 Filkngle RofatesYes 20fset=0 )

Command:

Sarcart | CPlares | SetVien | Diaply | Seect | Viewpr Laysu Vil Transkrm | Cve Tl | Surtce Toks Sl Toos  Mesh Tl Rerder Tocs | Draing  Hew V5 |
DBESTXB0~N +»2 5]

ARTH=«>2709000@ THLE,

“ Top | Perspective | Frone | Right | +
71 End ] Heor ] Port [ M 17 Con e [ P £ Ton (| ] Kt - Ve ) Fryect () D
CPlane | x74dsa | y-0732 | 10000 Waimeters |ggDetout GrdSnap | Oro | Planar | Osnap | Smariacs | Gumosll | Record istory | Fier 078

. IMOOMOONUMG M NRPGINIIRNGANEasso a passo do desenho. Clique duas
vezes na viewport “Top” para visualizar as quatro vistas, selecione o primeiro
circulo e todos os objetos que estdo dentro dele e clique em “Extrude closed
planar curve”. Na viewport “Right” digite 4 e tecle ENTER. (essa serd a
espessura do pingente)

116



12.

13.

B et (157 58 - inoceres ocntioma) 60600 b - e
R ol e Bt b2 i
4 v 3008010 3tecton

CIEPD
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1)t ] e | s [7]Con [ v ] P ] Tan £ i [ st ] Vot [ o [ st
crana | 143808 | 1757 20000 | Milimoes  EOetat GridSnap | Crbo | Flanar | Osnsp | Smarffrack | Gumbal | RecordHisiry | Fitar |Memeey use: 177ME.

INGINOON PONNGB UP@EPN NeEIO NNOPBO NFEDNO FNEDN NBpN
novamente na ferramenta “Extrude closed planar curve” e repita o processo
feito anteriormente com a mesma espessura.

R o

o ¥ Cmretnoues kA oo oatormis ooyt ol 8 Pt
Aulossve comeleled successtily -

fiie!

SREIHN/ S LIDAOTE
Simf FHA P ERGDLHING

g

ane | x18590 38303 | 30000 Mimetes |Dstatt

GNAPN O PNAERNPNEDBPN FEAQM OO0 NMIBM@M E8hho dos objetos a
cima, selecione o segundo e o terceiro circulo e os 30 objetos entre eles.
Selecione a ferramenta “Extrude closed planar curve”, digite 4 e tecle ENTER.

=ves 3| B
Sl Doy St Viewpsr Loy Vit Tresioem . o Tol _ Sibcn o S T e Tl _ Tk D Newin5. a
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{
i

SN FED0ROVAET 7| O
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14.

2z o o~ s

TNAINOON U PMEDMOGBNRENGPN OM NNB@MOfEXBMde closed planar
curve”, digite 4 e tecle ENTER, em seguida selecione a ferramenta “Offset
Surface”, digite 2 e tecle ENTER 3 vezes, certifique-se de ativar “Solid=Yes” e ao
clicar em “FlipAll” escolha a diregdo, as setas deverdo ficar para fora.

S forer
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CADEIRA CIRCULAR

JohnHebertAlvesBalbino
JoseVicentedaSilvaFilho
PASSO A PASSO

1. Solicite um novo documento (file/new ou Ctrl + n) e selecione Large Objects - Centimetres.

l!

Bowdp
o

| G e AR GRS I B

Cl " w r on e Omy e

2. Pressione duas vezes o botao esquerdo do mouse(clique duplo)e sobre a viewport TOP.

3. Na barra de ferramentas selecione a opc¢éo Circle: Diameter (circulo com didmetro a ser definido).

Digite o nimero 0(zero)(o desenho comegara na origem dos eixos guias) e pressione Enter .

4. Digite 60(Diametro do circulo), em seguida selecione a posigéo do circulo em relagéo aos eixo e clique na posi¢éo desejadas
(cima no meu caso).

5. Selecione na barra de ferramentas a opgao Rectangle: 3 Points.




6. Clique nos pontos 1, 2 e 3 Respectivamente indicados na imagem a seguir:

Fle Edt View Cuwe Sufsce Sobd Mesh Dwension [ransfonn Tock Anahoe Render Help

Widh Press Enter t use length ( Rounded )
Comman |

DEREEADNCA AP AP FH=®cx282000 1050

w@?q
BEE O . &

LS ebE0OEG
L §0l0 bR GQeJIUGML

TP FLEREY

| Bee i Clrn Cws wiom Ew Clew Dl o Coa o 0 STak o

Chlane » 6707 ya® 200 Woee Snap Orthe Plrar Osap  Recerd Hstory

7. Selecione na barra de ferramentas a opgao Trim selecione selecione os dois lados verticais do retangulo,
pressione Enter

File EOt Vww Cure Sufice Soid Mesh Dimwnsion Treforn Tooh Anabas Rende Haip
Undoing Tim
Command:

BESTXD0~N 3200 MAax-r 7880008 8% @

[
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e
el
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By e

i

EPEDRRPO>D EE

[CEd FMaw Citan CIMA @G Rk [Pen [1Tan [ 0ad [N (] Prisd ] STck ) Du
[T R 0m Wt Sap Ortho Plew Owwp  Fecord Hatory

em seguida selecione as partes do circulo a serem excluidas (partes contidas dentro do retangulo).

8. Selecione novamente a opgao Trim para obter a seguinte imagem. Selecione as partes do circulo
que sobraram (referéncia para corte),pressione Enter logo em seguida selecione a aresta superior do retangulo.

9. Selecione a opgéo de ferramenta Join, e clique em todas as partes do desenho.
(Unido da partes selecionas em uma s6 pega).
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Fia st dew Cams Gwwa abd Mun Dmimion Tamiem lash smyn b i

Sustoneionm n
Tt

DeEBSTXL0-~0+A0HREHEeecr@aM000@ @,

10. Selecione na barra de ferramentas a opgao Offset Curve digite 10 e pressione Enter
(criando uma cépia da imagem original, com a distancia de 10cm de cada aresta do desenho original.)

Fia it dew Cane Gwwa abd Mun Dmimion Taeiem lash smy bede i

e R yms

11. Cliqueforadagura,paracopiaraguraexternamente.

12. Selecione a opgao Copy na barra de ferramentas, e selecione a imagem maior e pressione Enter .
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13. Selecione Selecione a ferramenta Line, e fa,ca duas linhas como a seguir:

obteraseguintegura.

0 o futece Sobe Muh Dimamisn Tt Tach Anabss e
Sustoneationm | Unao
Commant ]

DEeEATXD0~0+A0HR2 H-e- 0880000 T®1L,Q

Eed Etew Bfst B @i B Elrep Bl B0m Fio (oo O 5imcl vt
Care vma T T " wp O Fun Omp g

15. Selecione a ferramenta Polyline (Lines Segments).
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Fia bt dew Camn s abd Mun Dmumion Taeiem less Amym bede Hik

Sustoneionm n
Tt

DEESTXL0~0+A0HREHee=rPaB000@ TBLO

Hed Etew Bfst B @om Bk Oeep ) ok (]t [ ] e
e vwis  gam wm i Sowp Ot Poar Omap Ry

16. Com a opgao Mid marcada na barra inferior, trace retas sequenciais de 5 e 15 respectivamente com indicado na figura.
(retas guias)
lhlﬁﬁ-mw—&uumhmlﬁmmm

P i 1o (el i Halpars=his L |
Frvar Evee whee do | Hrde-Le Heees=No L 01 T

NeEaUxnl-N+A20H0R A== RaB000d T@®LO

ot k] Pt (] Sk ] Ot
T smap Ome Punw Omap  Recor ey

17. A seguir do canto inferior direito da “perna” esquerda da imagem, trace reta para direita de 5, e logo em seguida
uma para cima até tocar a figura.

(obs: Facilitara caso o item Int(Intersecgdo) esteja marcada na barra inferior).

18. Com a opgao Perp(perpendicular), trace uma reta perpendicular ao desenho interno até tocar o desenho externo.
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. Com a opgédo Quad marcada no barra inferior, trace uma linha unindo os quadrantes superiores das duas imagens.

Fia it Ve Cane Gwiwa abd Mun Dmimion Taeiem lish smy bede i
Hpars o Leagn wnso

Do ] T e
sy Ot Poar O by

Selecione na barra de ferramenta a opgao Circle: Center, RadiusCirculo com raio a ser defindo
tendo como origem do circulo seu centro.
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21. Com a opgéo End marcada na barra inferior, selecione o fim(End) da primeira reta guia como centro, digite 3,
e pressione Enter , repita a processo para a segunda reta guia, e o mesmo processo inserindo circulos de raio 3
em cada ponto médio(Mid) das linhas guias, conforme a figura a seguir.

22. Selecione a ferramenta Copy, copie os dois circulos junta com as linhas guias tendo como ponto referéncia
o inicio da primeira linha guia ponto médio da aresta inferior do desenho e cole no ponto médio da outra aresta inferior
do desenho.

T T e T = ey
Futrin copy 1 FramasPaineh sol s Do eabasiDrsisrmbis
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e WD yum am [ Swp Do Blar Oumap ol Hidars

23. Com tecla Shift pressionada, selecione todas as linhas guias e em seguida na aba esquerda (Layers)
clique com o botdo ESQUERDO do mouse em uma das layers disponiveis (com excegéo do layer Defaut)
e selecione a opgdo Change Object layer todas as linhas ganharao a cor da layer selecionada.

em seguida clique na “Lampada” relacionada a layer escolhida para as linhas.(para oculta-las)
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24. Pressione duas vezes o botdo esquerdo do mouse (clique duplo)e sobre a viewport a fim de voltar as quatro vistas.
25. Pressione duas vezes o botdo esquerdo do mouse (clique duplo)e sobre a viewport Perspective.

26. Do ponto médio (Mid) da aresta inferior esquerda, trace 10 linhas sequenciais de 5 para cima.

Rt oo ooy R i
Sclctcueus s Esruoa. s Ertar anin donc
v, Press Eniee e e |

DeEaTXD0~N+A20 R H=-a>+0aB000 T@5L@

TS P E el LR

Gaae [bre [ Frones ] STewch ] Duse
Swp Oribo Blear Oup FacordHgnn  Seect et 1 D

27. Selecione a opgdo Extrude closed planar curve Selecione o objeto em forma de “ferradura”
incluindo seus circulos internos e pressione Enter , em seguida digite 2 extrusao de 2cm

C T —————r————
it ol pes (WatieL i Helparsebi Lo |
Cemmars:

DeEaTXD0~N+ A0 R H=-a> 088000 T@5L@

i [ k(2] Pt (] o ] Dt
[T Swp Oriho Plnar Omap P nan

repita o procedimento com a figura copiada no item 12, por’em fa,ca uma extruséo de 3.

28. Selecione a ferramenta copy selecione a “ferradura” e seus circulos, pressione Enter ,
selecione o ponto médio da aresta inferior com ponto de copia.

29. Em seguida faga copias colando cada copia no ponto final(End) das linhas guias, obtendo a seguinte imagem
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30. Selecione a ferramenta Circle: Center, Radius, fagca uma circunferéncia que coincida
com umas 7 contidas na cépia superior, e extrude (Extrude closed planar curve) para baixo
até que o centro coincida com o centro do ultimo circulo inferior da Gltima pega de baixo.

5080t o Ml s oo
Craatng mahes..Preas Ece sl
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32. Selecione a Ferramenta Move, selecione como ponto de ancoragem o vértice inferior esquerdo da segunda figura,
pressione Enter e mova a figura até o vértice superior externo da sexta pega do conjunto anterior.
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Resultado
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MODELAGEM DE UMA CHUPETA

Adalia Samara Alencar
Maria Wellida Da Silva Lima

Esse tutorial tem como objetivo descrever passo a passo como desenhar uma
chupeta em 3D, inspirada nas obras do pintor surrealista Salvador Dali, no Programa
Rhinoceros. Para um melhor desempenho ao fazer o passo a passo sugerimos que
construa o desenho utilizando layers (camadas).

PASSO A PASSO
1 - Crie um novo arquivo no Rhino com o
template“SmallObejectsCentimeters”. Salve o

arquivo com o nome “CHUPETA”.

2 -Copie ai magem ao lado e salve com nome
“chupeta”.

3 -Maximize a “Viewport Front” . Para inserir a
imagem, va até a barra de menus, cliqgue em
“View>Background Bitmap>Place”.

4 -Apés clicar em “Place”, clique no arquivo
“chupeta” e depois “Abrir”. Ainda na “Viewport
Front”, digite “0”(zero) na linha de comando, tecle
“Enter” para confirmar, digite “30” na linha de
comando e tecle “Enter” novamente.

5 -Para iniciar o desenho com a ferramenta “Line”, trace uma linha de referéncia
bem no meio da cabeca da chupeta, divid indo-a. Para facilitar, habilite o comando
“Ortho”. Selecione a ferramenta “Near” na barra de status.
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6 —Com a ferramenta “Curve>Curve: Interpolate Points” desenhe um lado da
cabeca. A opcéo “Ortho” deve estar desabilitada.
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7- Antes de criar o s6lido da cabega deve -se acionar aopgdo “End” na barra de
status. Depois clique em “Surface> Revolve”. Selecione a linha que representa a
metade da cabega da chupeta e pressione “Enter”. Clique na linha de referéncia, na
ponta de cima e na base da cabeca. Na linha de comando, escolha a opgéo
“FullCircle”e tecle “Enter” novamente. Veja como ficou na “Viewport
Perspective”.
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8 — Minimize a “Viewport Perspective”. Vaparaa “Viewport Front”, selecione
“Circle: Center, Radius”, use a linha de referéncia e logo a baixo clique e arraste a
circunferéncia paraa “Viewport Top” e na linha de comando digite “11” e tecle
“Enter”.

130



9 —Para criar o sélido da base habilite a ferramenta  “Near” e “End”, selecione a
ferramenta “Arc: Start, End, Directionat Start” . Na “Viewport Front” clique na
base da cabega e no circulo. Depois, com a ferramenta “Single Point” na
“Viewport Top”, faga um ponto no meio da circunferéncia e outro acima (com a
opcdo “Cen” selecionada).Agora selecione “Surface> Revolve” clique no arco
tecle “Enter”, clique nos dois pontos e tecle “Enter” duas vezes.
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10 —Dé volume a borda da base da chupeta, clique na linha da circunferéncia,

selecione aferramenta “Box: Cornerto Corner, Height>Pipe”. Na linha de
comando digite “2”, tecle “Enter”. Repita todo este procedimento na borda abaixo
da cabeca,desta vez digitando “1” na linha de comando.
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11 - Para criar a alga da chupeta use a “Viewport Front”. Va aferramenta “Arc:
Start, End, Point onArc” |, clique em dois pontos (com um tamanho proporcional)em
cima da base da chupeta e sem soltar o cursor, crie um arco proporcional ao

tamanho da chupeta. Para fazer o arco menor, use a ferramenta “Copy” e copie o
arco, depois reduza o seu tamanho com a ferramenta “Scale 2-D”. Com a
ferramenta  “Ortho” habilitada, ligue os dois arcos usando a ferramenta
“Polyline>Line”. Selecione tudo e clique na ferramenta  “Join”.
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12 - Para dar volume a alga da chupeta, utilize a ferramenta “Box: Cornerto
Corner, Height>Extr ude”. Na linha de comando digite “14” e tecle “Enter”. Agora
arredonde a alga utilizando a ferramenta “Boolean Union >VariableRadiusFillet” e
na linha de comando digite “0.5”, depois clique nas bordas uma a uma, pressionando
“Shift” , em seguida tecle “Ente r” duas vezes.
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13 — Para desenhar a boca va paraa “Viewport Front” e trace uma linha vertical
sobre a boca da chupeta dividindo-a ao meio, usando a ferramenta “Line”, para isso
a ferramenta “Ortho” deve estar habilitada. Em seguida use a ferramenta “Curve:
Interpolate Points” e desenhe duas linhas seguindo o contorno da boca, faga isso
somente de um lado. Selecione as duas linhas e com a ferramenta
“TransformMirror” espelhe o outro lado da boca. Agora selecione toda a boca e
cligue na ferramenta “Join” para unir a linhas.
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14 — Na “ViewportRight” vamos posicionar a boca de acordo  com a curva da
cabecga. Para isso use a ferramenta  “Curve Fromobject>Pull Curve toSurface ”,
selecione as duas linhas da boca e tecle “Enter”, depois clique na cabecae
tecle“Enter”’novamente. Aproveite a selecao e dé um “Join” na boca para unir as
linhas.
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15 -Na “Viewport Front” crie uma curva no meio da boca para ligar as duas linhas
que formam os labios, usando a ferramenta  “Arc: Start, End, Directionat Start”
(Use a “ViewportRight” como referéncia para verificar se o arco foi criado
corretamente).
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16 - Para dar volume aos labios volte para “Viewport Front” e use a ferramenta
“Surface>Sweep2Rails” clicando em todas as linhas, depois teclando  “Enter” e
em seguida clicando em “Ok”.
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17 — Para vazar a boca selecione a ferramenta  “Trim” clique na linha interna da
boca e tecle “Enter”, depois dé um clique dentro da boca.
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18 — Para desenhar o olho use a ferramenta “Curve>Curve: Interpolate Points” .
Use a ferramenta “Curve Fromobject>Pull Curve toSurface” (isso fara com que o
olho fiqgue de acordo com a cabega) , selecione a linhae tecle “Enter”, depois na
cabega e “Enter” novamente.
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19 —Para vazar o olho use 0 mesmo o mesmo procedimento feito com a boca(Passo
17).Feito isso, para dar volume ao olho, na “Viewport Front” trace uma curva
usando “Arc: Start, End, Directionat Start” no olho vazado(use a “Viewport
Perspective” para visualizar melhor). Agora clique em “Surface>Patch” clique na
linha do olho e na curva tecle “Enter”. Dé volume a linha do olho com “Solid>Pipe”
utilizando a medida “0.1”.
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UNIDADE 04

OBJETOS E
PERSONAGENS
FICTICIOS



PINGENTE RELIQUIAS DA MORTE, HARRY POTTER

Francisco Clayrton Santos
Rafael Monteiro Alves

1. Parainiciar a nossa criagdo vamos abrir o rhinoceros e selecionar a opgdo “Smal Objects
— milimeters”.

Select model size and units used when Rhino starts
|5 Larce Otjects - Cantimeters
[ Larce Otjects - Feet

[ Larce Otjects - inches

| Larce Otjects - Meters

i Larce Otjects - Milimeters
i Smat Objects - Centimeters
il Smal Objects - Fest

lig Smat Objects - Inches

I Sal Objects - Meters

38 Smat Objects - Millmeters

Help

2. Feito isso, maximize a janela “Top” dando um clique duplo sobre seu nome. Vamos usar
um esbogo para dar a silhueta do nosso pingente. Para abrir a imagem, va ao menu
“View > Background Bitmap > Place”.

nd
sme b5 @5 -
Rotae Cuteshito B

Page Layout v
Background Btmap . Place
Grid Options.

Captuse v

Shaded
Bendered

Ghested

Femesh

Display Opions.

Viewport Properties
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3. Ao clicar em “Place”, uma janela de selegdo ira se aparecer, vocé deve encontrar o
arquivo do esbogo, “Pingente”, clicar sobre ele e clicar em abrir. Logo apds fazer isso, o
programa ird solicitar o posicionamento da sua imagem. Primeiramente, digite o nimero
“0” e aperte “ENTER”, depois, digite “15” e aperte “ENTER”. Isso fard com que sua
imagem se posicione nos pontos 0, dos eixos x e y, e no ponto 15 do eixo y (verde).

4. Vamos comegar a desenhar a silhueta do pingente com a ferramenta “Polyline”. Use essa
ferramenta para percorrer as retas do esbogo e acompanhar sua silhueta. Use a
ferramenta “Circle” para fazer os circulos do desenho.

[y == N

i

rcle: Center, Radius

5. A proxima etapa serd esconder o esbogo que usamos. Para isso, va no menu “View >
Background Bitmap > Hide”. O seu desenho devera ficar como a imagem abaixo:

6. Agora nds iremos recortar as dreas que ndo serao utilizadas, par isso
vamos soltar alguns pontos dos triangulos internos da forma, usando a
ferramenta “Explode”.

7. Apds usar a ferramenta “Explode” vocé devera usar a ferramenta “Trim” para cortar as
partes indesejadas, e que seu desenho fique da seguinte forma:
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8. Agora Vamos unir as partes que ndo estdo se tocando, com a ferramenta “Control Points
On”, basta clicar na ferramenta e logo em seguida na linha ou curva que deseja mover,
essa ferramenta controla os pontos, tornando mais facil a movimentagédo do desenho.

9. Apods ajustar todos os pontos que estavam abertos, nés vamos criar um pequeno circulo
na parte superior do triangulo, esse circulo sera o orificio para a colocagdo do pingente.

10. Agora, vamos dar volume a peca. Saia da vista Top dando novamente um clique duplo
sobre seu nome. Entdo, clique no botdo da ferramenta “Extrude closed planar curves”:

11. Selecione todas as linhas desenhadas (clicando sobre cada uma delas ao mesmo tempo
em que segura a tecla “Shift”), digite “0.5” e aperte “ENTER” trés vezes seguidas. Veja a
dimensdo da nossa peca:
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12. V4 em “Layers” e selecione o objeto em “Change Object Layer”

- Selecione a cor desejada;

13. Por fim, é s6 renderizar o desenho e pronto.
Lembre-se de salvar o arquivo!
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Resultado




MODELAGEM DO ELMO
DO PERSONAGEM MAGNETO, X-MEN

Israel Vitor Amorim de Oliveira

1. Desenhe um circulo bem centralizado na vista “top”;

B e e e 0

e i ves e e e e e i e desyis eds vy
[T
DERECsb0~d+ 5003 Bma=rfoB000d T®50

LS

ra
I -

@&
o
&7
X3
@@
(=T
Lo
& <k
& &
3

pils
iy
L

2. Duplique os circulos na na vista “front” ou “right” e agrupe-os com a ferramenta “Join”;

3. Desenhe o arco, também como na figura abaixo, utilizando a ferramenta “Control Point
Curve”
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4. Duplique o arco e rotacione na vista “top”, utilizando a ferra menta “Rotate 2D” com base
no centro da vista, para que forme uma espécie de gaiola;

5. Clique na ferramenta “Sweep 2 Rails” e selecione os objetos. Quando aparecer uma
caixa de dialogo. Marque a opgdo “Closed Sweep” e clique em preview para visualizar o
resultado;
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6. Na face “right”, trace as linhas usando novamente a ferramenta “Control Point Curve”;
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7. Utilizando a ferramenta “Trim”, dé separe os pedagos que formardo o objeto e exclua os
pedacos excedentes;
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8. Para dar volume aos detalhes, selecione a camada e use a ferramenta “Offset Surface”,
dando valor de 2mm ao volume. Nao esquega de marcaropgao “solid” antes de dar enter.

9. Para dar cor ao objeto, selecione uma das camadas e cologaeesm outra. Para isso, na
janela das camadas, ao lado, basta selecionar o objeto e clicar com o direito em “Change
object layer”, selecionar outra das camaas selecionaveis, clicar com o botéo direito
novamente, e selecionar “Change object layer”. Isso transportara o objeto de uma camada a
outra.
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10. Ainda na janela das camadas, selecione as cores clicando nos circulos ao lado do nome.
Nisso, aparecera a seguinte caixa de dialogo.

a Material Edit : )

Assign by

() Plugin
(@ Basic |

Basic
Name
Color E}
Gloss colar :}
Gloss finish o b
Transparency [ £ail
=[] Testure
Map file {none} [:]
Intensity, % <
Filter [lon
Tiing [ Modfy.. ]
&1 [ Transparency
Map file {none} D
Intersity, % =
Filter
Tiling
& [ Bump
Map file (none} B
Intersity, % cal
Filter
Tiling
£l [ Environment
Map fils {none} D
Intensity, % o
Filter
Tiing [ Modiy.. |
[ Match.. ]

[ ok J[ concl |[ el |

Mude a cor no item color e repita o processo nos 2 objetos.

11. Resultado
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MODELAGEM DO MARTELO DE THOR

David Kennedy Ferrer Campos Sousa
Sara Silva Rocha

1- V4 na ferrementa Solid : Box Comer to Comer, Heigth.

g

2- Construa o sdlido.
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3- Use a ferramenta Solid Tools: Variable Radius Chamfer

Fde Edt View Cune Suface Soid Mesh Dimension Transforn Tools Analyie Render Help
Creating meshes.
Command:

OEETXD0~N 3P 0RFH=-«r 0 0R000R T®HL@
[Top |

SlRVEIVAZ

DEL @

CPlane x-20623 y TR 2000 Snap Ottha Planar Osnap Record History
L4

4-Na caixa comando digite 5 e aperte Enter.

Fie Edt View Curve Surface Solid Mesh Dimension Transform Tocls Analyre Render Help

‘Select edges 1o chaer { CureniChanferDistance=5 ) .
- Select edges to chamier | CureniChanmderCisance=5) |
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5- Selecione a ferramenta Curve: Interpole Points.
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6- Fagca uma forma semelhante & lateral do retangulo e em seguida
reduza para fazer as laterais menoresdo martelo.

Fie G Vma Cove Sdee skt Meh Omemien Tl Tok Anspm Feede Hel
vt pen Hupas=tes Laapn Unas
o]

HEFX B0+ 20 LREHE4x=77020000 1830
[Perspectben |

a

DEN R SEHOROVErT
LNl d bRA®S OGN

(EEa Fhew b @ Fitm D Dfa CTm 70wt %o CPuea (STl

149



8-Use a ferramenta Surface: Loft para unir as duas partes em um solido.
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11- Com a ferramenta Solid: Cylinder, fagca um cilindro e desloque-o para
parte superior do sélido.

12-Esconda a camada da parte superior do sélido para trabalhar o cabo.
13-Com a ferramenta Solid: Cylinder repita a mesma a¢ao e faga o cabo.

14- Use a ferramenta Circle:Center, Radius para criar um circulo poucos
milimetros maior que o diametro do cabo.
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15- Com a ferramenta Solid: Pipe.Flat caps dé a espessura do circulo criado.

16- Copie o circulo criado 11 vezes e selecione-0s, na caixa comando use 0.2 e Enter.
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17- Use a ferramenta Surface: Sweep 2 Rails, para criar a superficie ao redor
dos circulos.
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18- Use a ferramenta Solid Tools: Cap planar Holes para preencher o sélido.
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20- Use a ferramenta Solid Tools:Variable Radius Filet para
arredondar a superficie do sélido.
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24- Una 4 al¢a ao cabo, movendo-a.

25- Va na parte superior da barra de comandos, selecione View >
Brackground Bitmap > Place, para importar a imagem.

26-Selecione a vista Frontaluse a ferramenta Curve:Interpolate
Points para fazer o contorno daimagem.

155



27- Use a ferramenta Solid: Extrude Close Planar Curve e digite a espessura
desejada (2.5) no comando e aperte Enter

Feita a Extrusao...

e Gt St O i s o Rk

cosa

DeESFX00~04+,0AFB s 0AB0008 1056
a4 [Fepere

28- Acenda a camada do marteloUse a ferramenta Solid
Tool:Boolean Difference para grava-la no martelo.
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Com a imagem gravada no martelo, finalizamos o produto.
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ESPADA DE THUNDERA (THUNDERCATS)

Diogo Antonio Silva Ribeiro
José Jonathan Alencar de Lima

1- Salve a imagem abaixo em algum local do seu computador
(esta imagem servira de referencia para o nosso desenho)

2- Abra o rhino e escolha a opgdo large centimeters na vista top faca o seguinte comando
View>backgrond bitmap> place. Selecione a imagem da espada, digite (0) ENTER, depois (20) e ENTER

5% Untitied
File Edit | Mesh Dimension Transform Tools Analyze Ren
Choose bi Undo View Change Home |
Command g5 view Change End

urve  Surface ]

IBF=) Pan Shift+ RMB
il i Rotate Ctrl+ Shift+ RMB
o
h | = Zoom 3
HT Set View >
Gl Set CPlane »
Set Camera »
Viewport Layout »
Active Viewport G
Page Layout »
Background Bitmap » Place
Grid Options... Refresh
Capture » Remove

FEL P YY1 ¥ 1ok,
E ¥Hurtre RGO IO

Close Viewport it
Wireframe Jic

*  Shaded v
Rendered Lo
Ghosted Ak
an Scale
Flat Shade v Grayscale

Shade Selected Objects Only

Remesh

Display Options...

Viewport Properties...
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3- Com a ferramenta Curve-Interpolate Points, desenhe a «guarda» da espada
contornando a imagem como mostrado abaixo:

S IQSr-=d
5 Curve: | olate Poirts| (-
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4 - Feito o contorno da guarda, agora vamos ocultar a imagem por enquanto pois vamos precisar
ainda dela, para ocultar fazemos o mesmo processo sé que em vez de place sera hide

View>background bitmap>Hide

File

Drag obje« Unda View Change Home
Command

¥

Edit Curve Surface Solid Mesh Dimension Transform Tools Analyze Render Help

Redo View Change End

T R it D CH= &« =>7 7 o000 R T
Rotate Ctrl+Shift+ RMB
Zoom 5

Set View »
Set CPlane »
Set Comera »

Viewgort Layout »
Active Viewport »
Page Layout »

Background Btmap »|
Grid Options...
Capture -

Close Viewport
Wireframe
Shaded
Rendered
Ghosted
X-Ray

Align
Scale

QEFS e hBlO@BOVAY >
| §%+ ¢ bRy IN B -

Flat Shade
Shade Selected Objects Only

v Grayscale

Remesh
Display Options...
Viewport Properties...
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5 - O proximo passo serd dar volume ao cabo. Para isso va para a vista Perspective
e use a ferramenta: extrude closed planar curves ou simplesmente extrude,
marcando a opgdo: Solid no menu da barra de comando

.
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2

Extrude closed planar curve

6 - O proximo passo sera desenhar a lamina, desta vez com a ferramenta Polyline:
E logo apds utilize novamente a ferramenta Extrude para dar volume a lamina
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7 - Feito isso, vamos fazer a parte do cabo. Para tanto, usaremos a ferramenta Cylinder que se
encontra no sub-menu do solid junto do extrude.

File Edit View Curve Surface Solid Mesh Dimension Transform Tools Analyze Render Help
§Aulosave completed successfully
- Command:

SESTXDO~¢PLLLPPH=2a=29 8B00




8 - Crie um cilindro com o diametro um pouco menor do que o da parte superior do cabo como na
imagem abaixo:

Deixe-a o mais centralizado possivel e , va para a vista perspective e posicione de um
modo que a ponta da lamina.




9 - Com a ferramenta: Variable Radius Chanfer iremos achatar as bordas da lamina. Clique em:
Solid tools>variable radius chanfer como na imagem a baixo.

Untitied -
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Commang: I 0
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Creatas 3 nukd surface
between muitipe polysurface

with warying chamfes
distances, trims the orginal
faces, 5nd joms the chamfer
surlaces to them,

Steps:
1. Select eiges,
2. Selest 3 hand.

aptians
CurrentChamfertistance

Spacifies the dstanca for the
current hande,

AgaHandle
adkds & handie along the edges.

seta
Set the chamfer distancs for

Linkiandies
1F Yes, editing a single hande
will ipdate al handes,
RemoveHandia

Fie f@t few Cuve Sace Sobd Meh Dmemin Tomsiorm Tooh Ansye Render el
Setect et camter { CureniChameDstance= 1

Saloct wiges I chamer | CunriChante Dsance | [

DeEE8TXD0~N 0P Hes =988 000a T85:@

9] At Lt
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Creates a nued surface

batwesn multipis polysurtace
with warying chamfes

@atances, trims the onginl

Faces, and jons the chamfer

surfaces to them,

Steps:

1. Selact soges.

2. select 3 handis

optians
Currentchamferpistance
Spacifios the dstanca far the
curtsn hand.

AddHandie =
Ads a handie slong the sdges.
Ccopysandla

4dds 3 new handie using the
chamier dstance from the
selected handle.

setal
Sat the chamfer distance for
i handies.

Uinkhandies

IF Yes, aditing a single hande
will update ab handes.
RemoveHandia

P.S. Caso fique alguns cantos vivos( termo usado em joalheria para pontas)use a ferramenta trim
para retira-las
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"]
Draws 3 singla ine sagment.

staps:
1. Pick the start of the lins.
Pick the end of the ine.
Use abject snaps to
rafacanice ssisting
geometry.

10 - Agora faga com que a imagem da espada fique visivel novamente. O procedimento é esse:

View>backgrond bitmap> show

Dmemsion Teamsfcrm Tonk Aneye Rencer Hesp
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()
v

Undo
Ravarses racant changes to
copscts.

Notas
© Fis operations er changes
made to wewperts ar
ccastruction planes cannot
be undon by the Undo.
& the

UndoView command to
undo changas mads to tha
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11 - Selecione a ferramenta Curve: Interpolate Points, e faga os detalhes do cabo
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P.S. Para poupar tempo faga um lado e depois espelhe e posicione. Para isto, vd em:
Transform clique e segure e selecione Mirror
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12 - Faga a extrusao destas linhas com a ferramenta Extrude:

13 - A proxima ferramenta utilizada chama-se Boolean Diference, a qual serve para retirar a diferenga entre
dois objetos que no caso seria o revelo dos detalhes e a «guarda» da espada. Para isso selecione a
ferramenta na parte de Solid Tools, clique no relevo, aperte Enter e depois na superficie em

em vermelho.

14 - Agora iremos fazer o detalhe da «pedra» que possui o simbolo dos thundercats:
Para isso utilize a ferramenta de solidos - Elipsoid para gerar uma esfera e logo apos
utilize das ferramentas Scale 1d e Scale 2d para chegar ao tamanho ideal

15 - Faremos entdo os detalhes do cabo: Selecione a ferramente Circle e pela vista

front faga um circulo um pouco maior que o cabo:
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a tandera - Rhinoceros (Educational Lab License)
Fie fdt View Cuwe Sufice Soid Mesh Dimensin Tandfomn Took Anmshme Aender Help
L Render, version 100, Jul 72007, 123255 4
Command: Be »

DEE8TXD0~0+L0 R H=®cr cete S—
[ Top | Perspeclive Layers - All Layers.
DBxavd¥H1
Hame: Mater
1 Defouit v L
920ce ki
18 Crcle: Ceryer, R} by sol
- Layer 4 Ly |
Layer 05 esO

QEES e ShBLQ
E§%l e FR YR

LT [ e JPm [Fimd  Flcen F JPep [ Ten  Floued [FlKex l‘lm'srwl‘]m|
CPlane x-1208 2000 WOetut Snap Ortho Planar Osnap Record History
= —

16 - Depois do circulo feito, selecione ele e use a seguinte ferramenta solid e em seguida use a
ferramenta pipe flat caps. Para fazer uma argola mais proporcional use 0.2 de diametro digitando na
aba command. Logo apds duplique as argolas e posicione na extensdo do cabo.

F Cihe Cft O ftn Ot Dl Cie Dl D sl ek e
[ TN ) i e
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17 - Agora vamos passar para a base do cabo use a ferramenta cicle e faga dois circulos de tamanho
diferentes e um um pouco mais a frente do outro como na imagem

3 - Rhinoceros (Educational Lab License] ]
File Edit View Cuve Suface Solid Mush Dimension Transform Tools Anabyze Render Help
Drag objects: =

- Command: B« »
DEEHEFXA0~O+P00R P H=ec 7 8R000@ 859G )
= Layers-AllLayers - @
3 Bl awid
Name Mates
Defauit v -
Layer 01 von
Layer 02 von
Layer 03 von
Layer 04 von
Layer 05 ¢da

(Hed Flter FlPort @Md FlCn Flrt Fleep FlTon Floud [Fkna [Pkt [ STrck[] Diatie |
CPlane x-1151 y0.30 2000 WDt Smap  Ortho Planar Osnap  Record History
= P e S T e T

18 - Para gerar um solido a partir destes circulos, use a ferramenta Loft se se encontra na aba Surface
posicione ele junto do cabo e depois use outra ferramenta chamada Cap Planar Holes para ficar
como na imagem:

= . _=

File Edit View Curve Surace Sofid Mush Dimension Transform Took Anahyze Render Help
Creating meshes _ Press Escto cancel 2
Command:

DeE8Fxb0~0+0p0
o

APTH=x==>r702000@ "85:@

Layers - All Layess
I DB xavaTAT
Name Mates
Default v -
Layer 01 ¢ oM
Layer 02 vom
Layer 03 voam
Layer 04 com
Layer 05 vda

DSebP2OOHOVRT

(WEd [Chew FlPort @M e [Dw
CPlane  x -298.

Clpep [T [ Oud [0 Kot (] Propect () STrock ] Disaie |
Y2684 2000 0.0 WOt Snap  Ortho Planar Osnap  Record History
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19 - Vamos dar mais um detalhe na base do cabo em que estamos trabalhando,
arredondando um pouco mais a ponta. Para isso usaremos a ferramenta Solid>Variable
Radius Fillet e deixe como na imagem a seguir

(P S
File Edit View Curve Surface Solid Mesh Dimension Transform Tools Analyze Render Help

Select edges o fillet 5) 3
‘Command: B e »

LRPTH=»2=r7 0008 "65:@

DeEdaFfxD0~8H+pL
[Tos

o Name Maiey
Defmit ]
@’ Layer 01 -y
> Layer 02 com
& Layer 03 com
& Layer 04 -y |
Layer 05 edO

HFS e 20O

e

T i '

(Hed Flter FlPot @Md Flcn Pl Fleep FlTon Floud [ kna [ Prpect [ STrck[] Db |
CPlane x146. y-1920 2000 _ mDshut Smap  Ortho Planar Osnap  Record History

20 - Agora colocaremos as pedrarias no cabo com a ferramenta Esphere e vamos deixar assim como na

imagem:

(P S
File Edit View Curve Surface Solid Mesh Dimension Transform Tools Analyze Render Help

Render completed time: 00:00:01 -
‘Command: B e »

Dedafx D0~ L0 L2 H=s=r30R2000@ "85:@

Name Mates
Defmit ]
Layer 01 -y
Layer 02 -y |
Layer 03 com
Layer 04 -y |
Layer 05 edO

0|

»Qj‘ﬂq'\tﬂu ol
E§%le Hoo

T i '

(Hed Flter FlPot @Md FlCn Pl FlPep FlTon Flouwd [Fkna [ Prokect [ STrck[] Db |
CPlane_x-20T7 y-1507 2000 000 WDt Smap  Ortho Planar Osnap  Record History

use a ferramenta move e através das vista alinhe todas as esferas.
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21 - Agora vamos fazer o simbolo da pantera. Para isso mostre a imagem de fundo onde tem a pantera
e com a ferramenta: Curve: Interpolate Points e desenhe-a.
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Feito isso de um split e em seguida na parte selecionada um off-set surface
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Resultado:
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MODELAGEM DA PERSONAGEM EVE,

DA ANIMAGAO WALL-E

Leidiane BatistaLopes
Raimundo Wagner Gongalves

PASSO A PASSO:

1. Inserindo a imagem

Primeiramente, crie um novo arquivo em

centimetros.

Large Objects — Centimeters

-
Startup Template

Select model size and units used when Rhina starts

ESmaII Objects

Agora, escolha a visdo Front, e, sendo que Eve tera
aprox. 5cm X 2cm, faga duas retas, que serdo o eixo
base para o corpo. Utilize a ferramenta Polyline.

(Tenha a opgédo Ortho habilitada).
Lines > Polyline.

Start of polyline: 0 [enter]
Next point of polyline: 70 [enter]

Clique com o botédo esquerdo  do mouse para criar a

linha no sentido vertical no eixo verde.

Em seguida, digite 40, pressione enter. Clique com o
botéo esquerdo do mouse para criar a linha no sentido
horizontal acima do eixo vermelho e com o direito para

finalizar o comando.
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Coloque a imagem.

Cligue com o botao direito na janela Front, va em Background Bitmap >
Place. Encontre e escolha a imagem Eve1.jpg.

Digite 0 e pressione enter para definir o inicio da imagem.

Leve o cursor até perto do eixo horizontal
desenhado. Clique.

2. Desenhando o corpo

Para formar o eixo de rotagéo, mova a imagem para o centro do eixo verde, de modo que fique
dividida ao meio.

Ainda pela janela Front, selecione
Background Bitmap > Move. Leve a
imagem de fundo até que fique como a figura
ao lado. Clique.

(Mova para outra guia ou exclua as linhas que
ja ndo sao mais necessarias)

Agora desenhe o corpo a partir da imagem de fundo. Utilize a ferramenta Interpolate points.
(Desabilite a opgao Ortho e habilite as opgdes Osnap, End e Near).

Curve > Interpolate points.
Contorne a imagem inteira, se necessario edite os pontos

selecionando o desenho e utilizando a ferramenta Edit points
(F10) e finalize a agéo (F11).

Agora rotacione a curva para formar o solido. Utilize a ferramenta Revolve.

Surface > Revolve




Selecione a curva desenhada e pressione
enter. Clique em algum ponto do eixo
vertical e clique novamente em outro ponto
do mesmo eixo. Clique em algum ponto da
curva desenhada. Ficara algo como a figura
ao lado

Na janela Right, espelhe o objeto formado utilizando a ferramenta Mirror

Transform > Mirror

Selecione a curva a ser espelhada. Enter. Clique no comeco da
curva e em outro ponto préximo.

Uma as duas metades com a ferramenta Join.

Ficara como a imagem abaixo.

3. Cortando o corpo

Faca um solido em forma de elipse para moldar o que depois sera o espago da cabega.
Solid > Ellipsoid: From center > Ellipsoid: by diameter.

Na janela Front, clique no eixo vertical um pouco abaixo do visor e na ponta da figura.
Ainda na Janela Front, deixe a primeira elipse como na imagem abaixo.
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4. Fazendo a cabega

(mova para outra layer ou remova as lanhas -guia utilizadas no corpo, € mova o corpo para
outra layer para facilitar a construgao da cabeca).

Construa linhas-guia assim como foi feito no corpo, porém com as especificagdes abaixo:
(no eixo verde)

Start of polyline: 0
Next point of polyline: 5
Next point of polyline: 49

(no eixo horizontal acima da linha vermelha)

Next point of polyline: 50

Abra a imagem Eve2.jpg partindo do ponto feito 5cm acima na linha verde. Para encontra  -la
tenha a opgéo End habilitada.

Backgound Bitmap > Place
(Abra a imagem pedida)

Passe o cursor pela linha vertical até encontrar o ponto feito 5cm
acima do inicio da linha e abra a imagem até o fim da linha -guia
horizontal.

Mova a imagem até ficar partida ao meio pela linha vertical verde, utilize a ferramenta Move no
meu Background Bitmap.

Background Bitmap > Move.

Desenhe a cabega, usando a ferramenta ZZE=--_ 02
Interpolate points e assim como feito com o corpo,

desenhe apenas a metade dela, editando os pontos
com a ferramenta Edit points (ou f10) se necessario.

Rotacione a cabega usando a ferramenta Revolve, assim como feito com o corpo.

Surface > Revolve.
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Va a janela Right, deixe a ultima elipse como a figura abaixo.

Ficara assim:

Separe as partes usando a ferramenta Bolean difference.
Solid tools > Bolean Difference.

Selecione a parte do corpo (de baixo) pressione enter, depois selecione o ellipsoid (cima) e
enter.

E teremos o corpo:
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Selecione a curva desenhada, aperte enter. Clique em algum ponto do eixo verde, repita o
processo. Clique no lado oposto ao da curva desenhada, em seguida clique na curva.

2OHa a9 00008 TSHLE (P Beacr(ABO0DA THLO

Espelhe a forma criada na janela Right, usando a ferramenta Mirror.
Transform > Mirror

Clique na forma, aperte enter. Clique em algum ponto do eixo verde, clique novamente no eixo
verde de modo que as formas fiquem iguais. Ficara dessa forma.

Una as duas partes com a ferramenta Join.

5. Ovisor

Desenhe o visor, espelhe-o e junte as partes assim como nos d0|s itens anterlores

Curve > Interpolate points.

Desenhe a metade do visor e se necessario edite os pontos com
a ferramenta Edit points (ou f10).

Transform > Mirror
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Selecione a curva desenhada, clique em um ponto do eixo
verde. Clique novamente igualando as partes.

Junte as duas curvas usando a ferramenta Join.

Faca a extrusao da forma do visor.
Solid > Extrude closed planar curve.

Selecione o visor, aperte enter. Certifique -se que, na janela de comando esteja marcado:
BothSides=No, Cap=No, Deletelnput=No.

Na janela Right, leve a extruséo até ficar fora do limite da cabecga, ndo
importando o tamanho.

Contorne o visor na cabega.

Com a ferramenta Split, selecione a cabega, pressione enter e depois selecione o visor, aperte
enter.

(Mova para uma outra layer ou apague a superficie extrudada do visor).

6. Os olhos

Desenhe um dos olhos, usando a ferramenta Interpolate points e, em seguida, espelhe-o para
garantir a simetria.
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Torne os olhos solidos com a ferramenta Extrude closed planar curves.
Solid > Extrude closed planar curves.
Selecione um olho e o extruda. Assim como feito com o visor,

apenas o deixe fora da area da cabecga. Repita o processo com o
outro olho.

Faga uma copia do visor, que sera de vidro.

Selecione o visor. Aperte Ctrl+C, Ctrl+V.
Com a ferramenta Mover, leve uma das superficies do visor 1cm para dentro da cabega, como
mostra a figura abaixo.

(Para que ela fique  alinhada, tenha a opgéo
Ortho habilitada)

Depois, mova a superficie de cima do visor para
uma nova layer para ser usada depois.

Deixe o contorno dos olhos no visor com a ferramenta Split.

Extrude a forma criada dos olhos com uma distancia de 0.5cm
da superficie.

7. Os bragos

Da vista Front, desenhe o contorno dos bragos usando a
ferramenta Interpolate points, como mostra a figura:
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Faca a extrusdo da linha, com a ferramenta Extrude closed planar curves, com a opgéo
BothSides=Yes.

Para dar forma ao brago, primeiramente separe-os do corpo, com uma distancia de 5cm.

Desenhe uma curva para fechar o brago com a ferramenta Interpolate Points. Espelhe a curva
e depois crie uma borda do brago com a ferramenta Duplicate Edge.

Surface > Duplicate Edge.

Selecione a borda do brago e aperte enter.
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Crie a superficie do brago.
Surface > Loft

Selecione as curvas em ordem e
aperte enter. Na caixa de mensagem
que aparecer, deixe as informacdes
como na figura:

Crie o espaco do brago na superficie do corpo, copie e cole a superficie gerada no bracgo.

(Repita o processo com o outro brago)

8. Finalizando....

Digite, na barra de comando, a ferramenta BlenderSrf. Selecione as duas partes no visor, como
indicado na figura:

D

—D—

Same height shapes Preview

0K 3 Cancel | [ Hep |
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Uma as superficies do brago e do corpo com a ferramenta Join:

Na barra de comando digite FilletEdge. Clique na opgéo Radianus e digite 0.2, aperte enter.
Clique nas bordas do corpo e aperte enter duas vezes. Repita o processo em todas as jungdes
para que fiquem mais amenas.
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Acrescente detalhes como Cor, Brilho e/ou Transparencia no menu Layers.
Divirta-se!

"B Mmteril Edtor |===)
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@ Plugin I
I
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Layer 02 Yoo Name
Color (—
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=l [T Transparency
Map file C:\Users\Ripper'. B
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Tiing
&l [ Bump
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Tiling [ Modify... ]
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Resultado




BONEQUINHO DE LEGO

Ruberflanio Alencar Calheiro
Rita Edivanira Sa

Passo 1: Cabeca

+ Va na ferramenta Cylinder e digite 6 para a espessura, logo depois
digite 8 para a altura em seguida pressione Enter.
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Segure a ferramenta Boolean Union, logo depois na ferramenta
Vaiable Radius Fillet, e clique nas arestas de cima e de baixo do

cilindro, digite 1 e pressione Enter 3 vezes .
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Passo 2: Pescocgo

» Ferramenta Cylinder, digite 2 e depois digite 3 para altura.

QD’XEID“O*»@DI!QQE‘.\,Tﬁl!o@ﬁﬂ‘ﬁ%ﬂ

1 B s
=]
FE T
FRE
e

DEAIBRPLORG TG O
L&t bR GRS GH

"
s
F

Passo 3: Tronco

@&

| 6 Box: Comerto Comer, Height

* Va até Box, digite 14 dé Enter, digite 9 depois Enter, por ultimo
depois Enter.
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Passo 3: Tronco

» Segure a ferramenta Boolean Union, logo depois na ferramenta
Vaiable Radius Fillet, e clique em todas as arestas do cubo, digite
1 e pressione Enter 3 vezes.

Passo 3: Tronco

» Selecione todo o cubo, clique em Explosion,
» Selecione a parte central do cubo, Delete.
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Passo 3: Tronco

4

+ Selecione toda a parte de cima do cubo, depois clique na
ferramenta Scale, na vista top clique no centro da parte selecionada,
segure o botéo esquerdo do mouse de forma que escalone para
diminuir a parte de cima em relagéo a de baixo, mas sé um pouco.

QAN AEHORIVEAr T H
¥/ 2 RGO IN G- [

Passo 3: Tronco

* Agrupe a parte de cima do cubo com o comando Ctrl+G, faga o
mesmo na parte de baixo.

+ Digite Dupedge, dé Enter, na vista front arraste o mouse da
esquerda para a direita selecionando s6 as linhas de extremidade
das duas partes, em seguida aperte Enter.

FROBOCO0@ TR @
[Perpeaive |

........

DEEL e hALOREIVEF T
l?\}ﬁEFQQJJHGH‘;I
Goano
ECTCLTY

186



Passo 3: Tronco

s

* Ainda com as linhas selecionadas aperte na ferramenta Join
em seguida digite Loft e pressione Enter 3 vezes
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Em seguida selecione todo o tronco e dé um Join.

Passo 4: Pernas

9 &
| © Box: Comerto Comer, Height

+ Va até Box, digite 6 dé Enter, digite 7 depois Enter, por ultimo, logo
depois Enter.
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Passo 4: Pernas

@&

| B Box: Comerto Comer. Height

* Ainda na ferramenta Box, digite 6 dé Enter, digite 2 depois Enter
por ultimo 2 depois Enter.
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Passo 4: Pernas

» Depois de ter feito os dois cubos, na vista top deixe o menor
centralizado na frente do maior, porem um pouco para dentro do
mesmo.
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Passo 4: Pernas

» Selecione os dois, depois va em em Boolean Union e dé Enter
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Passo 4: Pernas

+ Em seguida na vista top selecione a perna e arraste para o lado
segurando Alt assim ira fazer uma copia.
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Passo 4: Pernas

* Em seguida na vista top selecione a perna e arraste para o lado
segurando Alt assim ira fazer uma copia.

Passo 5: Bracos

1
© Control Point Curve
@ Curve Through Points

» Va na ferramenta Control Point Curve na vista top, cligue em
algum ponto, digite 3 dé um Enter e faca uma linha reta para direita
e clique, digite 3, Enter, faca uma linha reta para baixo e clique e por
ultimo digite 7 e continue uma linha reta para baixo e clique.
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Passo 5: Bragos

« Com a linha selecionada, pressionando em Box vocé ira até a
ferramenta Pipe, flat caps, em seguida digite 2, Enter, e depois 2
novamente, Enter, clique com o bot&o direito do mouse em qualquer
parte da tela.
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Passo 5: Bragos

+ Em seguida na vista top selecione o braco e arraste para o lado
segurando Alt assim ira fazer uma copia.
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Passo 5: Bragos

Command: Mirror
Start of mirror plane ( 3Point Copy=res )|

» Depois que a copia ¢ feita a mesma € selecionada, digite Mirror
aperte Enter, na barra de comandos clique em Yes, na barra de
comandos e com o0 mouse gire o brago de forma a girar no sentido
contrario do primeiro braco.
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* Va na ferramenta Cylinder, vista top e digite 1 para a espessura,
logo depois digite 1.3 para a altura em seguida pressione Enter
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Passo 6: Maos

 Vaem Arc center, na vista front, digite 2 e coloque a linha para
direita bem reta, depois digite 180 e dé Enter
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+ Com alinha selecionada va até Pipe flat e digite 0.5, Enter,e 0.5 e
dé outro Enter
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Passo 6: Maos

* Usando as vistas e o cursor do seu mouse posicione o tubo acima
do cilindro de forma a ficar bem centralizado, depois selecione os
dois e clique em Boolean Union
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Passo 6: Maos

+ Com a méo selecionada na vista Right selecione a ferramenta
Rotate e digite 90 depois Enter
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Passo 6: Maos

*  Duplique as méos

» Centralize as maos no final do braco e depois Ctrl+G para agrupar,
faca o mesmo no outro braco.
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Passo 7: Juncao das pernas

9 &

O Box: Comer to Comer, Height

* Na ferramenta Box, digite 2, Enter, 7, Enter, por ultimo 2, Enter.
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Agora é s6 encaixar

» Ponha as pecas em seu devidos lugares, usando a ferramenta
Move, vocé pode até tentar fazer outras posi¢des para seu

personagem!
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